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Abstract32

This deliverable is the user manual for the INTO-CPS tool chain, an update33

of deliverable D4.2a [BLL+15]. It is targeted at those wishing to make use34

of the INTO-CPS technology to design and validate cyber-physical systems.35

As a user manual, this deliverable is concerned with those aspects of the tool36

chain relevant to end-users, so it is necessarily high-level. Other deliverables37

discuss finer details of individual components, including theoretical founda-38

tions and software design decisions. Readers interested in this perspective on39

the tool chain should consult deliverables D4.2b [PBLG16], D4.2c [BQ16],40

D4.2d [LNH+16], D5.2a [PLM16], D5.2b [BLM16], D5.2c [BHPG16], D5.2d41

[Gam16], D2.2a [ACM+16], D2.2b [FCC+16], D2.2c [CFTW16] and D2.2d42

[CW16].43
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1 Introduction97

This deliverable is the user manual for the INTO-CPS tool chain. The98

tool chain supports a model-based development and verification approach99

for Cyber-Physical Systems (CPSs). Development of CPSs with the INTO-100

CPS technology proceeds with the development of constituent models us-101

ing established and mature modelling tools. Development also benefits from102

support for Design Space Exploration (DSE). The analysis phase is primarily103

based on co-simulation of heterogeneous models compliant with version 2.0 of104

the Functional-Mockup Interface (FMI) standard for co-simulation [Blo14].105

Other verification features supported by the tool chain include hardware-106

and software-in-the-loop (HiL and SiL) simulation and model-based test-107

ing. Presently there is limited support for Linear Temporal Logic model108

checking of discrete models, with further model checking support being de-109

veloped.110

All INTO-CPS tools can be obtained from111

http://into-cps.github.io112

This is the primary source of information and help for users of the INTO-113

CPS tool chain. The structure of the website follows the natural flow of CPS114

development with INTO-CPS, and serves as a natural aid in getting started115

with the technology. In case access to the individual tools is required, pointers116

to each are also provided.117

Please note: This user manual assumes that the reader has a good under-118

standing of the FMI standard. The reader is therefore strongly encouraged to119

become familiar with Section 2 of deliverable 4.1d [LLW+15] for background,120

concepts and terminology related to FMI.121

The rest of this manual is structured as follows:122

• Section 2 provides an overview of the different features and components123

of the INTO-CPS tool chain.124

• Section 3 explains the relevant parts of the Modelio SysML modelling125

tool.126

• Section 4 explains the different features of the main user interface of127

the INTO-CPS tool chain, called the INTO-CPS Application.128

• Section 5 describes the separate modelling and simulation tools used in129

elaborating and verifying the different constituent models of a multi-130

model.131
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• Design Space Exploration (DSE) for INTO-CPS multi-models is pre-132

sented in Section 6.133

• Section 7 describes model-based test automation and model checking134

in the INTO-CPS context.135

• Section 9 provides a short overview of code generation in the INTO-136

CPS context.137

• The appendices are structured as follows:138

– Appendix A lists the acronyms used throughout this deliverable.139

– Appendix B gives background information on the individual tools140

making up the INTO-CPS tool chain.141

– Appendix C describes how the individual tools can be obtained.142

– Appendix D gives background information on the various princi-143

ples underlying the INTO-CPS tool chain.144

2 Overview of the INTO-CPS Tool Chain145

The INTO-CPS tool chain consists of several special-purpose tools from a146

number of different providers. Note that it is an open tool chain so it is147

possible to incorporate other tools that also support the FMI standard for148

co-simulation and we have already tested this with numerous external tools149

(both commercial as well as open-source tools). The constituent tools are150

dedicated to the different phases of co-simulation activities. They are dis-151

cussed individually through the course of this manual. An overview of the152

tool chain is shown in Figure 1. The main interface to an INTO-CPS co-153

simulation activity is the INTO-CPS Application. This is where the user154

can design co-simulations from scratch, assemble them using existing FMUs155

and configure how simulations are executed. The result is a co-simulation156

multi-model.157

The design of a multi-model is carried out visually using the Modelio SysML158

tool, in accordance with the SysML/INTO-CPS profile described in D2.2a159

[ACM+16]. Here one can either design a multi-model from scratch by specify-160

ing the characteristics and connection topology of Functional Mockup Units161

(FMUs) yet to be developed, or import existing FMUs so that the connections162

between them may be laid out visually. The result is a SysML multi-model of163

the entire co-simulation, expressed in the SysML/INTO-CPS profile. In the164

8
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Figure 1: Overview of the structure of the INTO-CPS tool chain.

former case, where no FMUs exist yet, a number of modelDescription165

.xml files are generated from this multi-model which serve as the starting166

point for constituent model construction inside each of the individual simu-167

lation tools, leading to the eventual FMUs.168

Once a multi-model has been designed and populated with concrete FMUs,169

the Co-simulation Orchestration Engine (COE) can be invoked to execute170

the co-simulation. The COE controls all the individual FMUs in order to171

carry out the co-simulation. In the case of tool-wrapper FMUs, the model172

inside each FMU is simulated by its corresponding simulation tool. The tools173

involved are Overture [LBF+10], 20-sim [Con13] and OpenModelica [Lin15].174

RT-Tester is not under the direct control of the COE at co-simulation time, as175

its purpose is to carry out testing and model checking rather than simulation.176

The user can control a co-simulation, for instance by running it with different177

simulation parameter values and observing the effect of the different values178

on the co-simulation outcome.179

Alternatively, the user has the option of exploring optimal simulation pa-180

rameter values by entering a Design Space Exploration phase. In this mode,181

9



D4.3a - INTO-CPS Tool Chain User Manual (Public)

ranges are defined for various parameters which are explored, in an intel-182

ligent way, by a design space exploration engine that searches for optimal183

parameter values based on defined optimization conditions. This engine in-184

teracts directly with the COE and itself controls the conditions under which185

the co-simulation is executed.186

3 Modelio and SysML for INTO-CPS187

The INTO-CPS tool chain supports a model-based approach to the develop-188

ment and validation of CPS. The Modelio tool and its SysML/INTO-CPS189

profile extension provide the diagramming starting point. This section de-190

scribes the Modelio extension that provides INTO-CPS-specific modelling191

functionality to the SysML modelling approach.192

The INTO-CPS extension module is based on the Modelio SysML extension193

module, and extends it in order to fulfill INTO-CPS modelling requirements194

and needs. Figure 2 shows an example of a simple INTO-CPS Architecture195

Structure Diagram under Modelio. This diagram shows a System, named

Figure 2: Example INTO-CPS multi-model.
196

“System”1, composed of two EComponents of kind Subsystem, named “Sub-197

System”2. These Subsystems have an internal Variable called “variable” of198

type String and expose two FlowPorts named “portIn” and “portOut”. The199

type of data going through these ports is respectively defined by types In200

1An abstract description of an INTO-CPS multi-model.
2Abstract descriptions of INTO-CPS constituent models.
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and Out of kind StrtType. More details on the SysML/INTO-CPS profile201

can be found in deliverable D2.2a [ACM+16].202

Figure 3 illustrates the main graphical interface after Modelio and the INTO-203

CPS extension have been installed. Of all the panes, the following three are

Figure 3: Modelio for INTO-CPS.
204

most useful in the INTO-CPS context.205

1. The Modelio model browser, which lists all the elements of your model206

in tree form.207

2. The diagram editor, which allows you to create INTO-CPS design ar-208

chitectures and connection diagrams.209

3. The INTO-CPS property page, in which values for properties of INTO-210

CPS subsystems are specified.211

3.1 Creating a New Project212

In the INTO-CPSModelling workflow described in Deliverable D3.2a [FGPP16],213

the first step will be to create, as depicted in Figure 4, a Modelio project:214

1. Launch Modelio.215

2. Click on File → Create a project....216

11
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Figure 4: Creating a new Modelio project.

3. Enter the name of the project.217

4. Enter the description of the project.218

5. If it is envisaged that the project will be connected to a Java develop-219

ment workflow in the future (unrelated to INTO-CPS), you can choose220

to include the Java Designer module by selecting Java Project, other-221

wise de-select this option.222

6. Click on Create to create and open the project.223

Once you have successfully created a Modelio project, you have to install224

the Modelio extensions required for INTO-CPS modelling, i.e. both Modelio225

SysML and INTO-CPS extensions, as described at226

http://into-cps.github.io227

If both modules have been correctly installed, you should be able to create,228

under any package, an INTO-CPS Architecture Structure Diagram in order229

to model the first subsystem of your multi-model. For that, in the Mode-230

12
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lio model browser, right click on a Package element then in the INTO-CPS231

entry, choose Architecture Structure Diagram as shown in Figure 5. Fig-232

ure 6 represents an example of an Architecture Structure Diagram. Besides

Figure 5: Creating an Architecture Structure diagram.
233

creating an Architecture Structure Diagram from scratch, the INTO-CPS234

extension allows the user to create it from an existing modelDescription235

.xml file. A modelDescription.xml file is an artifact defined in the236

FMI standard which specifies, in XML format, the public interface of an237

FMU. To import a modelDescription.xml file,238

1. Right click in the Modelio model browser on a Package element, then239

in the INTO-CPS entry choose Import Model description, as shown in240

Figure 7.241

2. Select the desired modelDescription.xml file in your installation242

and click on Import (Figure 8).243

This import command creates an Architecture Structure Diagram describing244

the interface of an INTO-CPS block corresponding to the modelDescrip-245

tion.xml file imported, cf. Figure 9. Once you have created several such246

blocks, either from scratch or by importing modelDescription.xml files,247

you must eventually connect instances of them in an INTO-CPS Connection248

Diagram. To create an INTO-CPS Connection diagram, as for an INTO-249

CPS Architecture Structure Diagram, right click on a Package element, then250

13
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Figure 6: Example Architecture Structure diagram.

in the INTO-CPS entry choose Connection Diagram, as shown in Figure 10.251

Figure 11 shows the result of creating such a diagram. Once you have created252

all desired block instances and their ports by using the dedicated command in253

the Connection Diagram palette, you will be able to model their connections254

by using the connector creation command (Figure 12). At this point your255

blocks have been defined and the connections have been set. The next step256

is to simulate your multi-model using the app. For that you must first gen-257

erate a configuration file from your Connection diagram. Select the desired258

Connection diagram, right click on it and in the INTO-CPS entry choose259

Generate configuration, as shown in Figure 13. In the final step, choose a260

relevant name and click on Generate.261

3.2 Exporting modelDescription.xml Files262

The SysML Connection diagram defines the components of the system and263

their connections. The internals of these block instances are created in264

the various modeling tools and exported as FMUs. The modeling tools265

Overture, 20-sim and OpenModelica support importing the interface def-266

inition (ports) of the blocks in the Connection diagram by importing a267

14
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Figure 7: Importing an existing model description.

Figure 8: Model description selection.

modelDescription.xml file containing the block name and its interface268

definition.269

Follow these steps to export a modelDescription.xml file from Mode-270

lio:271

1. In Modelio, right-click on the model block in the tree.272

2. Select INTO-CPS → Generate Model Description (see Figure 14).273

3. Choose a file name containing the text “modelDescription.xml” and274

click Export (see Figure 15).275

15
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Figure 9: Result of model description import.

Figure 10: Creating a Connection diagram.
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Figure 11: Unpopulated Connection diagram.

Figure 12: Populated Connection diagram.
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Figure 13: Generating a configuration file.

Figure 14: Exporting a modelDescription.xml file.
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Figure 15: Naming the model description file.
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4 The INTO-CPS Application276

This section describes the INTO-CPS Application(here referred to as the277

app), the primary gateway to the INTO-CPS tool chain. Section 4.1 gives278

an introductory overview of the app. Section 4.2 describes how the app279

can be used to create new INTO-CPS co-simulation projects. Section 4.3280

describes how multi-models can be assembled. Section 4.4 describes how co-281

simulations are configured, executed and visualized. Section 4.5 lists some282

additional useful features of the app, while Section 4.6 describes how the283

co-simulation engine itself can be started manually, for specialist use.284

4.1 Introduction285

The app is the front-end of the entire INTO-CPS tool chain. The app defines286

a common INTO-CPS project and it is the easiest way to configure and287

execute co-simulations. Certain features in the tool chain are only accessible288

through the app. Those features will be explained in their own sections289

of the user manual. This section introduces the app and its basic features290

only.291

Releases of the app can be downloaded from:292

https://github.com/into-cps/intocps-ui/releases293

Four variants are available:294

• -darwin-x64.zip – MacOS version295

• -linux-x64.zip – Linux (64 bit) version296

• -win32-ia32.zip – Windows (32 bit) version297

• -win32-x64.zip – Windows (64 bit) version298

The app itself has no dependencies and requires no installation. Simply unzip299

it and run the executable. However, certain app features require Git3 and300

Java 84 to be already installed.301

3https://git-scm.com/
4http://www.oracle.com/technetwork/java/javase/overview/

java8-2100321.html

20
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4.2 Projects302

An INTO-CPS project contains all the artifacts used and produced by the303

tool chain. The project artifacts are grouped into folders. You can create304

as many folders as you want and they will all be displayed in the project305

browser. The default set of folders for a new project, shown in Figure 16, is:306

Figure 16: INTO-CPS project shown in the project browser.
307

Design Space Explorations Scripts and configuration files for performing308

DSE experiments.309

FMUs FMUs for the constituent models of the project.310

Model Checking Configuration files for performing Model Checking exper-311

iments.312

Models Sources for the constituent models of the project.313

Multi-Models The multi-models of the project, using the project FMUs.314

This folder also holds configuration files for performing co-simulations.315

SysML Sources for the SysML model that defines the architecture and con-316

nections of the project multi-model.317

Test-Data-Generation Configuration files for performing test data gener-318

ation experiments.319

In order to create a new project, select File → New Project, as shown in320

Figure 17a. This opens the dialog shown in Figure 17b, where you must321

choose the project name and location – the chosen location will be the root322

21
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(a) New Project menu entry. (b) New Project dialog.

Figure 17: Creating a new INTO-CPS project.

(a) Import Git Project menu entry. (b) Import Git Project dialog.

Figure 18: Importing a Git project.

of the project, so you should manually create a new folder for it. To open an323

existing project, select File → Open Project, then navigate to the project’s324

root folder and open it.325

To import a project stored in the Git version control system, select File →326

Import Project from Git, as shown in Figure 18a. This opens the dialog shown327

in Figure 18b, where you must choose the project location and also provide328

the Git URL. The project is checked out using Git, so any valid Git URL329

will work. You must also have Git available in your PATH environment330

variable in order for this feature to work. It is possible to import several331

public example projects that show off the various features of the INTO-CPS332

tool chain. These examples are described in Deliverable D3.5 [PGP+16]. To333

import an example, select File → Import Example Project, as shown in Figure334

19a. This opens the dialog box shown in Figure 19b, where you must select335

which example to import and a project location. The example is checked out336

via Git, so you must have Git available in your path in order for this feature337

to work. For both Git projects and examples, once you begin the import338

22
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(a) Import Example Project menu. (b) Import Example Project dialog.

Figure 19: Importing examples.

process, a process dialog is displayed, as shown in Figure 20.339

Figure 20: Progress of project imports through Git.

4.3 Multi-Models340

For any given project, the app allows you to create and edit multi-models341

and co-simulation configurations. To create a new multi-model, right click342

the Multi-models node in the project browser and select New multi-model,343

as shown in Figure 21. After creation, the new multi-model is automatically344

opened for editing. To select an existing multi-model for editing, double-345

click it. Once a multi-model is open, the multi-model view, shown in Figure346

22 is displayed. The top box, Overview, displays an overview of the input347

and output variables in the FMUs, as shown in Figure 23. The bottom box,348

Configuration, enables the user to configure the multi-model. In order to349

configure a multi-model, it must first be unlocked for editing by clicking the350

Edit button at the bottom of the Configuration box. There are four main351

areas dedicated to configuring various aspects of a multi-model.352

The FMUs area, shown in Figure 24, allows you to remove or add FMUs353

23



D4.3a - INTO-CPS Tool Chain User Manual (Public)

Figure 21: Creating a new multi-model.

Figure 22: Main multi-model view.

and to associate the FMUs with their files by browsing to, or typing, the354

path of the FMU file. For each FMU file a marker is displayed indicating355

whether the FMU is supported by the app and can be used for co-simulation356

on the current platform. The FMU instances area, shown in Figure 25,357

allows you to create or remove FMU instances and name them. A multi-358

model consists of one or more interconnected instances of various FMUs.359

More than one instance may be created for a given FMU. As a convenient360

workflow shortcut, the Connections area, shown in Figure 26, allows you361

to connect output variables from an FMU instance into input variables of362

another:363

1. Click the desired output FMU instance in the first column. The output364

variables for the selected FMU appear in the second column.365

24
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Figure 23: Multi-model overview.

Figure 24: FMUs configuration.

2. Click the desired output variable in the second column. The input366

instances appear in the third column.367

3. Click the desired FMU input instance in the third column. The input368

variables for the selected FMU appear in the fourth column.369

4. Check the box for the desired input variable in the fourth column.370

This facility makes it unnecessary to return to Modelio whenever small371

changes must be made to the connection topology of the multi-model. The372

Initial values of parameters area, shown in Figure 27, allows you to set the373

25
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Figure 25: FMU instances configuration.

Figure 26: Connections configuration.

initial values of any parameters defined in the FMUs:374

1. Click the desired FMU instance in the Instance Column.375

2. Select the desired parameter in the Parameters dropdown box and click376

Add.377

3. Type the parameter value in the box that appears.378

Once the multi-model configuration is complete, click the Save button at the379

bottom of the Configuration box.380
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(a) Parameter selection.

(b) Parameter value input.

Figure 27: Initial values of parameters configuration.
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4.4 Co-simulations381

With the INTO-CPS tool chain it is possible to distribute a co-simulation382

across several computing nodes such that FMUs need not be co-located with383

the COE on the same node. This capability caters to situations in which384

FMUs are restricted to simulation on specific platforms for reasons of legacy385

technology, licensing etc. In the current version of the tool chain this func-386

tionality is not fully integrated with the app, and requires the user to start387

the simulation procedure manually. This is discussed in Section 4.6 below.388

The remainder of this section discusses standard co-simulations on a single389

computing node.390

To execute co-simulations of a multi-model, a co-simulation configuration is391

needed. To create a co-simulation configuration, right click the desired multi-392

model and select Create Co-Simulation Configuration, as shown in Figure393

28. After creation, the new configuration automatically opens for editing.394

To select an existing co-simulation configuration, double-click it. Once a

Figure 28: Creating a co-simulation configuration.
395

configuration is open, the co-simulation configuration, shown in Figure 29, is396
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displayed. The top box, Configuration, lets you configure the co-simulation.397

The bottom box, Simulation, lets you execute the co-simulation. In order to

Figure 29: Main co-simulation configuration view.
398

configure a co-simulation, the configuration must first be unlocked for editing399

by clicking the Edit button at the bottom of the Configuration box. There400

are three things to configure for a co-simulation, discussed next.401

The top area, shown in Figure 30, allows you to select the start and end402

time for the co-simulation as well as the master algorithm to be used. For

Figure 30: Start/End time and master algorithm configuration.
403

every algorithm, there are configuration parameters that can be set. These404

are displayed below the top area, as shown in Figure 31. These parameters405

differ with the master algorithm chosen. The Livestream Configuration area,406

shown in Figure 32, allows you to select which variables to live stream and407

plot during the co-simulation. Every instance in the multi-model is displayed408

and the output variables are shown for each instance. Check the box for each409

variable that you wish to live stream. Once the co-simulation configuration is410

complete, click the Save button at the bottom of the Configuration box.411

The Simulation box, shown in Figure 33, allows you to launch a co-simulation.412

To run a co-simulation, the COE must be online. The area at the top of the413
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(a) Fixed step size.

(b) Variable step size.

Figure 31: Master algorithm configuration.

Simulation box displays the status of the COE. If the COE is offline, you414

may click the Launch button to start it. Once a co-simulation is in progress,415

any variables chosen for live streaming are plotted in real time in the simula-416

tion box, as shown in Figure 34. A progress bar is also displayed. When the417

simulation is complete, the live stream plot can be explored or exported as418

a PNG image. In addition, an outputs.csv file is created containing the419

values of every FMU output variable at every point in time in the simula-420

tion. This file can be double-clicked and it will open with the default system421

program for CSV files. It can also be imported into programs such as R,422

MATLAB or Excel for more complex analysis. Furthermore, it is possible423

to add a Post-processing script that receives the csv file name and the total424

simulation time as arguments. It is also possible to configure the amount of425

logging performed by the Co-Simulation Orchestration Engine.426
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Figure 32: Livestream configuration.

(a) COE offline. (b) COE online.

Figure 33: Launching a co-simulation.
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Figure 34: Live stream variable plot.

Figure 35: Co-simulation results file.
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4.5 Additional Features427

The app has several secondary features, most of them accessible through428

the Window menu, as shown in Figure 36. They are briefly explained be-429

low.430

Figure 36: Additional features.

Show Settings displays a settings page where various default paths can431

be set. Development mode can also be enabled from this page, but this432

feature is primarily meant to be used by app developers for testing.433

Show COE Server Status displays a page where you can launch and434

stop the COE as well as observe its log.435

Show Download Manager displays a page where installers can be down-436

loaded for the various tools of the INTO-CPS tool chain, including the437

COE.438

Show FMU Builder displays a page that links to a service where source439

code FMUs can be uploaded and cross-compiled for various platforms.440

Note that this is not a secure service and users are discouraged from441

uploading proprietary FMUs.442

4.6 The Co-Simulation Orchestration Engine443

The heart of the INTO-CPS Application is the Co-Simulation Orchestration444

Engine (COE). This is the engine that orchestrates the various simulation445

tools (described below), carrying out their respective roles in the overall co-446

simulation. It runs as a stand-alone server hosting the co-simulation API on447
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port 8080. It can be started from the app, but it may be started manually at448

the command prompt for testing and specialist purposes by executing:449

java -jar coe.jar 8082450

TCP port 8082 will be chosen by default if it is omitted in the command451

above. The COE is entirely hidden from the end user of the INTO-CPS app,452

but parts of it are transparently configured through the main interface. The453

design of the COE is documented in deliverable D4.1d [LLW+15].454

The COE is controlled using simple HTTP requests. These are documented455

in the API manual, which can be obtained from the COE’s own web page by456

navigating to http://localhost:8082. Port 8082 should be changed to457

that specified when the COE is started.458

Following the protocol detailed in the API document, a co-simulation session459

can be controlled manually from the command prompt using, for example,460

the curl utility, as demonstrated in the following example.461

With the COE running, a session must first be created:462

curl http://localhost:8082/createSession463

This command will return a sessionID that is used in the following com-464

mands.465

Next, assuming a COE configuration file called coeconf.json has been466

created as described in the API manual, the session must be initialized:467

curl -H "Content-Type: application/json"468

--data @coeconf.json469

http://localhost:8082/initialize/sessionID470

Assuming start and end time information has been saved to a file, say471

startend.json, the co-simulation can now be started:472

curl -H "Content-Type: application/json"473

--data @startend.json474

http://localhost:8082/simulate/sessionID475

Once the co-simulation run ends, the results can be obtained as follows:476

curl -o results.zip477

http://localhost:8082/result/sessionID/zip478

The session can now be terminated:479

curl http://localhost:8082/destroy/sessionID480
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The app fundamentally controls the COE in this way.481

Distributed co-simulations Presently the app can only control the COE482

in this way for non-distributed co-simulations. In order to run a distributed483

co-simulation, a distributed version of the COE, dcoe, must be controlled484

from the command prompt manually, as illustrated above. The distributed485

COE can be downloaded using the App’s Download Manager.486

In a distributed co-simulation the COE and (some) FMUs execute on physi-487

cally different compute nodes. The FMUs local to the COE computing node488

are handled in the same way as in standard co-simulations.489

Each FMU on the remote nodes is served externally by a daemon process.490

This process must be started on the remote node manually as follows:491

java -jar daemon*-jar-with-dependencies.jar -host492

<public-ip> -ip4493

Here, <public-ip> is the IPv4 address of the compute node.494

Next, the distributed COE process must be started manually from the com-495

mand prompt on its own node, with options specific to distributed co-simulation:496

java -Dcoe.fmu.custom.factory=497

org.intocps.orchestration.coe.distribution.498

DistributedFmuFactory499

-jar dcoe*-jar-with-dependencies.jar500

The second difference is the way in which the location of the remote FMUs501

is specified. For a standard co-simulation, the “fmus” clause of the co-502

simulation configuration file (coeconf.json, in our example) contains el-503

ements of the form504

“file://fmu-1-path.fmu”505

These must be modified for each remote FMU to the following URI scheme:506

“uri://<public-ip>/FMU/#file://local-fmu-path.fmu”507

The COE configuration file can, of course, be written manually in its entirety,508

but it is possible to take a faster route, as follows.509

This configuration file is only generated when a co-simulation is executed. It510

is therefore possible to assemble a “dummy” co-simulation that is similar to511

the desired distributed version, but with a local FMU topology. Since it is512

likely that the remote FMUs are not supported on the COE platform itself,513
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it is necessary here to construct “dummy” FMUs with the same interface.514

If this local co-simulation is then executed briefly, a COE configuration file515

will be emitted that can be easily modified as described above. The app516

will name this file config.json and emit it to the Multi-models folder517

under each co-simulation run. This modified configuration can then be used518

to execute the distributed co-simulation.519

5 Using the Separate Modelling and Simula-520

tion Tools521

This section provides a tutorial introduction to the FMI-specific functionality522

of each of the modelling and simulation tools. This functionality is centered523

on the role of FMUs for each tool. For more general descriptions of each tool,524

please refer to Appendix B.525

5.1 Overture526

Overture implements export of both tool-wrapper as well as standalone FMUs.527

It also has the ability to import a modelDescription.xml file in order to528

facilitate creating an FMI-compliant model from scratch. A typical workflow529

in creating a new FMI-compliant VDM-RT model starts with the import530

of a modelDescription.xml file created using Modelio. This results in531

a minimal project that can be exported as an FMU. The desired model is532

then developed in this context. This section discusses the complete work-533

flow.534

5.1.1 Installing the FMI import/export plugin for Overture535

In order to use the FMI integration in Overture it is necessary to install a536

plugin. Below is a guide to install the plugin:537

1. Open Overture.538

2. Select Help -> Install New Software.539

3. Click Add...540

4. In the Name: field write Overture FMU.541
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5. In the Location: field there are two options:542

INTO-CPS Application: Download theOverture FMU Import / Ex-543

porter - Overture FMI Support using the Download Manager men-544

tioned in Section 4.5. Locate the file using the Archive... button545

next to the Location: field.546

Update site: Enter the following URL in the Location: field:547

http://overture.au.dk/into-cps/vdm-tool-wrapper/master/latest.548

6. Check the box next to Overture FMI Integration as shown in Figure549

37.550

7. Click Next or Finish to accept and install.551

Figure 37: Installing Overture FMI Integration

5.1.2 Import of modelDescription.xml File552

A modelDescription.xml file is easily imported into an existing, typ-553

ically blank, VDM-RT project from the project explorer context menu as554

shown in Figure 38. This results in the project being populated with the555

classes necessary for FMU export:556

• A VDM-RT system class named “System” containing the system def-557

inition. The corresponding “System” class for the water tank controller558

FMU is shown in Listing 39.559

• A standard VDM-RT class named “World”. This class is conventional560

and only provides an entry point into the model. The corresponding561

“World” class for the water tank controller FMU is shown in Listing 40.562

• A standard VDM-RT class named “HardwareInterface”. This class con-563

tains the definition of the input and output ports of the FMU. Its struc-564
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Figure 38: Importing a modelDescription.xml file.

ture is enforced, and a self-documenting annotation scheme5 is used565

such that the “HardwareInterface” class may be hand-written. The566

corresponding “HardwareInterface” class for the water tank controller567

FMU is shown in Listing 41.568

• The library file Fmi.vdmrt which defines the hardware interface port569

types used in “HardwareInterface”.570

5The annotation scheme is documented on the INTO-CPS website into-cps.
github.io under “Constituent Model Development → Overture → FMU Import/Export.
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�
system System

instance variables

-- Hardware interface variable required by FMU Import/Export
public static hwi: HardwareInterface := new

HardwareInterface();

instance variables

public levelSensor : LevelSensor;
public valveActuator : ValveActuator;
public static controller : [Controller] := nil;

cpu1 : CPU := new CPU(<FP>, 20);
operations

public System : () ==> System
System () ==
(
levelSensor := new LevelSensor(hwi.level);
valveActuator := new ValveActuator(hwi.valveState);

controller := new Controller(levelSensor, valveActuator);

cpu1.deploy(controller,"Controller");
);

end System
� �
Figure 39: “System” class for water tank controller.
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�
class World

operations

public run : () ==> ()
run() ==
(start(System‘controller);
block();
);

private block : () ==>()
block() ==
skip;

sync

per block => false;

end World
� �
Figure 40: “World” class for water tank controller.

�
class HardwareInterface

values
-- @ interface: type = parameter, name="minlevel";
public minlevel : RealPort = new RealPort(1.0);
-- @ interface: type = parameter, name="maxlevel";
public maxlevel : RealPort = new RealPort(2.0);

instance variables
-- @ interface: type = input, name="level";
public level : RealPort := new RealPort(0.0);

instance variables
-- @ interface: type = output, name="valve";
public valveState : BoolPort := new BoolPort(false);

end HardwareInterface
� �
Figure 41: “HardwareInterface” class for water tank controller.
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The port structure used in the “HardwareInterface” class is a simple inheri-571

tance structure, with a top-level generic “Port”, subclassed by ports for spe-572

cific values: booleans, reals, integers and strings. The hierarchy is shown in573

Listing 42. When a model is developed without the benefit of an existing574

modelDescription.xml file, this library file can be added to the project575

from the project context menu, also under the category “Overture FMU”.576

577

With all the necessary FMU scaffolding in place, the VDM-RT model can be578

developed as usual.579

5.1.3 Tool-Wrapper FMU Export580

Models exported as tool-wrapper FMUs require the Overture tool to sim-581

ulate. Export is implemented such that the VDM interpreter and its FMI582

interface are included in the exported FMU. Overture tool-wrapper FMUs583

currently support Win32, Win64, Linux64, Darwin64 and require Java 1.7584

to be installed and available in the PATH environment variable.585

A tool-wrapper FMU is easily exported from the project context menu as586

shown in Figure 43. The FMU will be placed in the generated folder.587

588
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�
class Port

types
public String = seq of char;
public FmiPortType = bool | real | int | String;

operations

public setValue : FmiPortType ==> ()
setValue(v) == is subclass responsibility;

public getValue : () ==> FmiPortType
getValue() == is subclass responsibility;

end Port

class IntPort is subclass of Port

instance variables
value: int:=0;

operations
public IntPort: int ==> IntPort
IntPort(v)==setValue(v);

public setValue : int ==> ()
setValue(v) ==value :=v;

public getValue : () ==> int
getValue() == return value;

end IntPort

class BoolPort is subclass of Port

instance variables
...
� �

Figure 42: Excerpt of “Fmi.vdmrt” library file defining FMI interface port
hierarchy.
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Figure 43: Exporting a tool-wrapper FMU.
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5.1.4 Standalone FMU Export589

In contrast to tool-wrapper FMUs, models exported as standalone FMUs590

do not require Overture in order to simulate. Instead, they are first passed591

through Overture’s C code generator such that a standalone implementation592

of the model is first obtained. Once compiled, this executable model then593

replaces the combination of VDM interpreter and model, and the FMU ex-594

ecutes natively on the co-simulation platform. Currently Mac OS, Windows595

and Linux are supported, with embedded platform support for SiL and HiL596

simulation under development.597

The export process consists of two steps. First, a source code FMU is ob-598

tained from Overture as shown in Figure 44. Second, the INTO-CPS Appli-599

cation must be used to upload the resulting FMU to the FMU compilation600

server using the built-in facility described in Section 4.5. This is accessed by601

navigating to Window → Show FMU Builder.602

Please note that only some features of VDM-RT are currently supported by603

the C code generator. This is discussed in more detail in Section 9.604

5.2 20-sim605

This section explains the FMI and INTO-CPS related features of 20-sim6.606

We focus on the import of modelDescription.xml files, standalone and607

tool-wrapper FMU export (FMU slave), 3D visualization of FMU operation608

and an experimental FMU import (FMU master) feature. The complete609

20-sim tool documentation can be found in the 20-sim Reference Manual610

[KGD16].611

5.2.1 Import of modelDescription.xml File612

In Modelio it is possible to export the desired interface for a new FMU613

from a multi-model as a modelDescription.xml file (see Section 3.2.614

20-sim can automatically generate an empty 20-sim submodel 7 from this615

modelDescription.xml file with this desired FMU interface. To use616

6Note that 20-sim is Windows-only. However, it can run fine using Wine [Win16] on
other platforms. For details on using 20-sim under Wine, contact Controllab.

7Please note that the term “submodel” here should not be confused with the INTO-CPS
notion of a “constituent model”. A submodel here is a part in a graphical 20-sim model.
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Figure 44: Exporting a standalone FMU.

the modelDescription.xml import, you will need to use the “4.6.2-617

intocps” version of 20-sim8, since this feature is still under development. A618

modelDescription.xml file can be imported into 20-sim by using Win-619

dows Explorer to drag the modelDescription.xml file onto your 20-sim620

model (see Figure 45). This creates a new empty submodel with a blue icon621

that has the same inputs and outputs as defined in the modelDescription622

.xml file.623

5.2.2 Tool-wrapper FMU Export624

A tool-wrapper FMU is a communication FMU that opens the original model625

in the modelling tool and takes care of remotely executing the co-simulation626

8You can download the INTO-CPS version of 20-sim using the Download Manager in
the INTO-CPS Application.
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Figure 45: Import a ModelDescription in 20-sim.

steps inside the modelling using some tool-supported communication mecha-627

nism. 20-sim supports co-simulation using the XML-RPC-based DESTECS628

co-simulation interface [LRVG11]. The generation of a tool-wrapper FMU629

involves two steps that will be explained below:630

1. Extend the model with co-simulation inputs, outputs and shared design631

parameters.632

2. Generate a model-specific tool-wrapper FMU.633

The tool-wrapper approach involves communication between the co-simula-634

tion engine (COE) and the 20-sim model through the tool-wrapper FMU.635

The 20-sim model should be extended with certain variables that can be636

set or read by the COE. These variables are the co-simulation inputs and637

outputs. They can be defined in the model in an equation section called638

externals:639 �
640

externals641

real global export mycosimOutput;642

real global import mycosimInput;643 
� �644

To make it possible to set or read a parameter by the co-simulation engine,645

it should be marked as ’shared’:646 �
647

parameters648

// shared design parameters649

real mycosimParameter (’shared’) = 1.0;650 
� �651

The next step is to generate a tool-wrapper FMU for the prepared model.652
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This requires at least the “4.6.3-intocps” version of 20-sim9. This version of653

20-sim comes with a Python script that generates a tool-wrapper FMU for654

the loaded model.655

To generate the tool-wrapper FMU:656

1. Make sure that the tool-wrapper prepared 20-sim model is saved at657

a writable location. The tool-wrapper FMU will be generated in the658

same folder as the model.659

2. Open the prepared 20-sim model in 20-sim.660

3. Run the BATCH script:661

C:\Program Files (x86)\20-sim 4.6\addons\FMI\662

ToolwrapperFMUExport\generate.bat663

Note that the (x86) is only for 64-bit versions of Windows.664

4. You can find the generated tool-wrapper fmu as <modelname>.fmu in665

the same folder as your model.666

5.2.3 Standalone FMU Export667

Starting with 20-sim version 4.6, the tool has a built-in option to generate668

standalone co-simulation FMUs for both FMI 1.0 and 2.0 (note that version669

2.0 must be used here).670

To export a 20-sim submodel as a standalone FMU, make sure that the part671

of the model that you want to export as an FMU is contained in a submodel672

and simulate your model to confirm that it behaves as desired.673

Next, follow these steps (see also Figure 46):674

1. In the Simulator window, choose from the menu: Tools.675

2. Select Real Time Toolbox.676

3. Click C-Code Generation.677

4. Select the FMU 2.0 export for 20-sim submodel target.678

5. Select the submodel to export as an FMU.679

6. Click OK to generate the FMU. This will pop-up a blue window.680

9You can download the INTO-CPS version of 20-sim using the Download Manager in
the INTO-CPS Application.
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Figure 46: Export an FMU from 20-sim.

Note that to automatically compile the FMU, you will need the Microsoft681

Visual C++ 2010, 2013 or 2015 compiler installed (normally included with682

Microsoft Visual Studio, either Express or Community edition). If 20-sim683

can find one of the supported VC++ compilers, it starts the compilation684

and reports where you can find the newly generated FMU. The 20-sim FMU685

export also generates a Makefile that allows you to compile the FMU on686

Windows using Cygwin, MinGW, MinGW64 or on Linux or MacOS X.687

20-sim can currently export only a subset of the supported modelling lan-688

guage elements as standalone C-code. Full support for all 20-sim features is689

only possible through the tool-wrapper FMU approach (described shortly in690

Section 5.2.2). The original goal for the 20-sim code generator was to export691

control systems into ANSI-C code to run the control system under a real-692

time operating system. As a consequence, 20-sim currently only allows code693

generation for discrete-time submodels or continuous-time submodels using694

a fixed-step integration method. Support for variable step size integration695

methods is not yet included by default in the official 20-sim 4.6 release, but it696

is already included in the 20-sim “4.6.2-intocps” release and on GitHub (see697

below). Other language features that are not supported, (or are only partly698
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supported) for code generation, are:699

• Hybrid models: Models that contain both discrete- and continuous-700

time sections cannot be generated at once. However, it is possible to701

export the continuous and discrete blocks separate.702

• File I/O: The 20-sim “Table2D” block is supported; the “datafromfile”703

block is not yet supported.704

• External code: Calls to external code are not supported. Examples705

are: DLL(), DLLDynamic() and the MATLAB functions.706

• Variable delays: The tdelay() function is not supported due to707

the requirement for dynamic memory allocation.708

• Event functions: timeevent(), frequencyevent() statements709

are ignored in the generated code.710

• Fixed-step integration methods: Euler, Runge-Kutta 2 and Runge-711

Kutta 4 are supported.712

• Implicit models: Models that contain unsolved algebraic loops are713

not supported.714

• Variable-step integration methods: Vode-Adams andModified Back-715

ward Differential Formula (MeBDF) are available on GitHub (see below716

for the link).717

The FMU export feature of 20-sim is being improved continuously based on718

feedback from INTO-CPS members and other customers. To benefit from719

bug fixes and to try the latest FMU export features like variable step size720

integration methods (e.g. Vode-Adams and MeBDF), you can download the721

latest version of the 20-sim FMU export template from:722

https://github.com/controllab/fmi-export-20sim723

Detailed instructions for the installation of the GitHub version of the 20-sim724

FMU export template can be found on this GitHub page. The GitHub FMU725

export template can be installed alongside the existing built-in FMU export726

template.727

5.2.4 3D Animation FMU728

It is possible to visualize a 20-sim simulation as a live 3D animation. This 20-729

sim 3D animation can be exported as a 3D animation FMU that can be used730
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for visualization purposes in a FMI co-simulation experiment. An example731

of a 3D animation FMU in action is shown in Figure 47.732

Figure 47: 3D animation FMU

To create a 3D animation FMU, you will need to create a 3D animation in733

20-sim that reacts to some signals first (identical to the creation of standard734

3D animation in 20-sim):735

1. Open your 20-sim model.736

2. Open the simulator and add a new 3D animation window using View737

→ New 3D animation window.738

3. Create a new 3D animation scene by following the instructions from739

the Animation toolbox section in the 20-sim Getting Started manual740

[KG16].741

4. For elements that should move or change color based on external sig-742

nals, create one equation submodel in 20-sim with all required input743

signals for the animation.744

5. Connect the 3D animation object to the signals from this animation745

submodel.746

The next step is to export the 3D animation as standalone scenery:747

1. Go to the 3D animation plot in your 20-sim model.748
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2. Right-click in the 3D animation plot and select Plot properties.749

3. Choose File → Save scene.750

4. Select Yes to save the whole scenery.751

5. Save the scenery under the name scenery.scn.752

The 3D animation FMU uses the just exported scenery.scn file. Since753

the 3D animation is only a view of the simulation results, the FMU only has754

a list of inputs. To generate a modelDescription.xml file with the right755

FMU interface, a Python script must be executed which collects the list of756

external signals referred to by the exported scenery. This Python script and757

other required resources can be found in the following Controllab GitHub758

repository:759

https://github.com/controllab/fmi-3D-animation760

To generate the FMU modelDescription.xml file, do the following:761

1. Copy the generated scenery.scn in the fmu_sources\resources762

folder under 3D FMU instructions.763

2. Update FMU_GUID in the scenery_to_fmu.py Python script with764

a new GUID for your 3D Animation FMU.765

3. Execute the scenery_to_fmu.py Python script, e.g. using the Python766

installation that comes with 20-sim 4.6:767

• Start IPython found under 20-sim 4.6 in theWindows Start Menu.768

• cd <my 3D FMU instructions path>769

• run scenery_to_fmu.py770

This parses the scenery.scn file for objects that point to vari-771

ables/parameters (references). The variables/parameters are trans-772

lated to FMU inputs and FMU parameters. The 3D scenery does773

not contain any information that indicates whether the referred774

name is a variable or a parameter. As a workaround, all names775

that start with parameter. are marked as as FMU parameters776

(causality = parameter), while all others are generated as inputs777

(variability = continuous). This script also generates a scenery.778

txt file with the list of found references. This file is read by the779

3D animation DLL to couple the FMU interface to the 3D scenery780

objects. The output resembles that shown in Figure 48.781

4. Create the actual FMU:782

51

https://github.com/controllab/fmi-3D-animation


D4.3a - INTO-CPS Tool Chain User Manual (Public)

• Copy all needed textures to the fmu_sources\resources folder.783

• Zip the fmu_sources folder.784

• Rename the Zip file, e.g. 3DAnimationFMU.fmu.785

Figure 48: Generating modelDescription.txt file from 3D scenery.

5.2.5 FMI 2.0 Import786

The “4.6.2-intocps” version of 20-sim has an experimental option to import787

an FMU directly in 20-sim for co-simulation within 20-sim itself. This is788

useful for quickly testing exported FMUs without the need to set-up a full789

co-simulation experiment in the app. Presently only FMI 2.0 co-simulation790

FMUs can be imported.791

The procedure for importing an FMU as 20-sim submodel is similar to im-792

porting a modelDescription.xml file. Follow these steps to import an793

FMU in 20-sim:794

1. Copy/move the FMU to the same folder as your model. This is not795

required but recommended to prevent embedding hardcoded paths in796

your model.797

2. Using Windows Explorer, drag the FMU file on your 20-sim model (see798

Figure 49).799
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Figure 49: Importing an FMU in 20-sim.

This creates a new submodel with a blue icon that acts as an FMU wrap-800

per. FMU inputs and outputs are translated into 20-sim submodel input801

and output signals. FMU parameters (scalar variables with causality “pa-802

rameter”) are also available in 20-sim. This means that you can alter the803

default values of these FMU parameters in 20-sim. The altered FMU param-804

eters are transferred to the FMU during the initialization mode phase of the805

FMU.806

5.3 OpenModelica807

This section explains the FMI and INTO-CPS related features of Open-808

Modelica. The focus is on import of modelDescription.xml files, and809

standalone and tool-wrapper FMU export.810

5.3.1 Import of modelDescription.xml File811

OpenModelica can import modelDescription.xml interface files cre-812

ated using Modelio and create Modelica models from them. To use the813

modelDescription.xml import feature, you will need to use OpenMod-814

elica nightly-builds versions, as this extension is rather new. Nightly builds815

can be obtained through the main INTO-CPS GitHub site:816

http://into-cps.github.io817

To import a modelDescription.xml file in OpenModelica one can use:818
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1. The OpenModelica Connection Editor GUI (OMEdit): FMI → Import819

FMI Model Description.820

2. A MOS script, i.e. script.mos, see below.821 �
822

// start script.mos823

// import the FMU modelDescription.xml824

importFMUModeldescription("path/to/modelDescription.xml");825

getErrorString();826

// end script.mos827 
� �828

The MOS script can be executed from command line via:829 �
830

// on Linux and Mac OS831

> path/to/omc script.mos832

// on Windows833

> %OPENMODELICAHOME%\bin\omc script.mos834 
� �835

The result is a generated file with a Modelica model containing the inputs836

and outputs specified in modelDescription.xml. For instance:837 �
838

model Modelica_Blocks_Math_Gain_cs_FMU "Output the product839

of a gain value with the input signal"840

Modelica.Blocks.Interfaces.RealInput u "Input signal841

connector" annotation(Placement(transformation(extent842

={{-120,60},{-100,80}})));843

Modelica.Blocks.Interfaces.RealOutput y "Output signal844

connector" annotation(Placement(transformation(extent845

={{100,60},{120,80}})));846

end Modelica_Blocks_Math_Gain_cs_FMU;"847 
� �848

This functionality will ultimately be integrated in the OMEdit (the Open-849

Modelica Connection Editor) graphical user interface.850

5.3.2 FMU Export851

Currently all FMUs exported from OpenModelica are standalone. There are852

two ways to export an FMU:853

1. From a command prompt.854

2. From OMEdit (OpenModelica Connection Editor).855
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FMU export from a command prompt To export an FMU for co-856

simulation from a Modelica model a Modelica script file generateFMU.mos857

containing the following calls to the OMC compiler can be used:858 �
859

// load Modelica library860

loadModel(Modelica); getErrorString();861

862

// load other libraries if needed863

// loadModel(OtherLibrary); getErrorString();864

865

// generate the FMU: PathTo.MyModel.fmu866

translateModelFMU(PathTo.MyModel, "2.0", "cs");867

getErrorString();868 
� �869

Next, the OMC compiler must be invoked on the generateFMU.mos script:870 �
871

// on Linux and Mac OS872

> path/to/omc generateFMU.mos873

// on Windows874

> %OPENMODELICAHOME%\bin\omc generateFMU.mos875 
� �876

FMU export from OMEdit One can also use OMEdit (the OpenMod-877

elica Connection Editor) to export an FMU as detailed in the figures be-878

low.879

• Open OMEdit (see Figure 50).880

• Load the model in OMEdit (see Figure 51).881

• Open the model in OMEdit (see Figure 52).882

• Use the menu to export the FMU (see Figure 53).883

• The FMU is now generated (see Figure 54).884

The generated FMU will be saved to %TEMP%\OpenModelica\OMEdit.885

886
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Figure 50: Opening OMEdit.

Figure 51: Loading the Modelica model in OMEdit.

56



D4.3a - INTO-CPS Tool Chain User Manual (Public)

Figure 52: Opening the Modelica model in OMEdit.

Figure 53: Exporting the FMU.
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Figure 54: Final step of FMU export.
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6 Design Space Exploration for INTO-CPS887

This section provides a description of tool support for design space explo-888

ration (DSE) developed as part of the INTO-CPS project. Presently the889

INTO-CPS Application does not provide support for automated creation of890

the configuration files required to define a DSE experiment. Therefore, this891

section is split into three parts. Section 6.1 describes how the INTO-CPS892

Application can be used to launch a DSE using an existing configuration893

file and Section 6.2 describes how the results from DSE are generated and894

stored. Section 6.3 describes the structure of the DSE configuration file, giv-895

ing enough detail for the user to be able to edit one for their purposes.896

6.1 How to Launch a DSE897

To launch a DSE we need to provide the INTO-CPS Application with the898

path to two files. The first is the DSE configuration, defining the parameters899

of the design space, how it should be searched, measured and the results com-900

pared. The second is the multi-model configuration, defining the base model901

that will be used for the search. A DSE configuration is selected by double902

clicking on one of the configurations listed in the Design Space Explorations903

section of the INTO-CPS Application project explorer; these configurations904

are identified with the ( ) icon. If the COE is not already running, the905

DSE page is shown with a red “Co-simulation engine not running” status,906

as shown in Figure 55.907

If this is the case, click on the Launch button to start the COE. This re-908

sults in a green co-simulation engine status (see Figure 56). With the DSE909

configuration selected and the COE running, the next step is to select the910

multi-model to use. One can be selected from the Co-simulation Configura-911

tion drop-down box, as shown in Figure 57. Pressing the Simulate button912

starts the DSE background process.913
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Figure 55: Status when COE is not running.

Figure 56: Status when COE is running.

Figure 57: Selecting a multi-model.
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6.2 Results of a DSE914

The DSE scripts store their results in a folder named for the date and time915

at which the DSE was started. This folder may be found underneath the916

name of the DSE script selected, as shown in Figure 58. When the DSE has917

finished, we can find both a graphs folder and an HTML results page inside918

the results folder. It may be necessary to refresh the project view to see these919

new items. The results HTML file is identified by the ( ) icon, and double920

clicking on it opens the results page in the default browser.

Figure 58: Icon shown when DSE results are ready.
921

The results, shown in Figure 59, contain two elements. The first element is922

a Pareto graph showing the results of all simulations on a single plot, with923

each point on the graph representing a single simulation. The best designs,924

referred to as the non-dominated set, are shown in blue, with ranks of progres-925

sively worse designs coloured alternately red and yellow. The second element926

is a table of these results, with the rank in the left hand column, followed927

by the objective values and finally the design parameters that produced the928

result.929

6.3 How to Edit a DSE Configuration930

Editing of a DSE configuration is currently a manual process and so guidance931

regarding each section of the configuration is presented in this section.932
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Figure 59: A page of DSE results.

6.3.1 File Creation933

The suggested procedure for creating a new configuration is to make a copy934

of an existing one and then to edit the required sections. The individual935

configurations are located in their own folders within the Design Space936

Exploration folder of the INTO-CPS Application project directory, such937

as the pilot study with the line following robot “LFR-2SensorPositions” con-938

figuration shown in Figure 60 (see [PGP+16]). Using your OS’s file browser,939

create a new folder under DSEs and then copy in and rename a DSE configu-940

ration. The names of the new folder and configuration folder can be chosen at941

will, but the configuration file must have the extension .dse.json .942
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Figure 60: Location of DSE configurations.

6.3.2 Parameters943

The parameters section is used to define a list of values for each parameter944

to be explored. Figure 61 shows the definition of four parameters, each with945

two values. If a parameter is included in the DSE configuration file, then it946

must have at least one value defined. The order of the values in the list is947

not important. If a parameter that is to be explored is not in the list, its ID948

may be found in the three ways listed below.949

1. If the parameter is listed in the multi-model configuration, then copy950

it from there.951

2. If the parameter is not in the multi-model parameters list then its name952

may be found by examining the model description file in the associated953

FMU. In this case it will be necessary to prepend the parameter ID954

with the ID for the FMU and the instance ID of the FMU, for example955

in “{sensor1FMU}.sensor1.lf_position_x”.956

• the ID of the FMU is {sensor1FMU}.957

• the instance ID of the FMU in the multi-model is sensor1.958

• the parameter ID is lf_position_x.959

3. The IDs for each parameter may also be found on the Architecture960

Structure Diagram in the SysML models of the system. The full name961

for use in the multi-model may then be constructed as above.962
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Figure 61: Example parameter definitions.

6.3.3 Parameter Constraints963

It may be the case that not all combinations of the parameter values defined964

in the previous section are valid. So, it is necessary to be able to define965

constraints over the design parameters such that no time is wasted simulating966

invalid designs. For example, in the line follower robot we define ranges for967

the x and y co-ordinates of the left and right sensors separately, and running968

all combinations of these leads to asymmetric designs that do not have the969

same turning behaviour on left and right turns. To prevent this we can define970

boolean expressions based upon the design parameters and evaluate these971

before a simulation is launched. Figure 62 shows two constraints defined for972

the line follower DSE experiment that ensure only symmetrical designs are973

allowed. The first constraint ensures the y co-ordinates of both sensors are974

the same, while the second constraint ensures that the x co-ordinate of the975

left sensor is the same, but negated as the x co-ordinate of the right sensor.976

Note that the names used when defining such constraints have the same977

FMU_ID.instance_ID.parameter_ID format as used when defining a978

parameter range (see Section 6.3.2)979

Since the constraints are processed using the Python eval function, any980

boolean expression compatible with it may be used here.

Figure 62: Example parameter constraints.
981
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6.3.4 Scenario List982

The DSE scripts currently have limited support for scenarios referring to a983

specific set of conditions against which the multi-model is to be tested. In984

the example of the line following robot, the scenario refers to the map the985

robot has to follow, along with its starting co-ordinates. For instance, in986

one scenario the robot would go around a circular track in one direction,987

predominantly turning left, whereas in a different scenario the same track988

would be followed in the opposite direction, predominantly turning right. In989

both scenarios the map of the track is the same.990

Changing a scenario may involve changing one or more different parts of991

the multi-model and its analysis, such as the specific FMUs used, parame-992

ters passed to an FMU, the multi-model the DSE is based upon, along with993

any data files used by the objective scripts (Section 6.3.6) to evaluate perfor-994

mance. This feature is currently under development and so only the objective995

data file selection is implemented presently.996

6.3.5 Objective Definitions: Internal997

There are two means for defining the objectives used to assess the perfor-998

mance of a simulated model. The first of these, described here, is using the999

internal functions included in the DSE scripts. This is a set of simple func-1000

tions that can be applied to any of the values recorded by the COE during1001

simulation. The current set of internal functions is:1002

max Returns the maximum value of a variable during a simulation.1003

min Returns the minimum value of a variable during a simulation.1004

mean Returns the mean value of a variable during a simulation (n.b., a fixed1005

simulation step size is currently assumed.)1006

Defining an internal objective requires three pieces of information:1007

name This is the name that the objective value will be stored under in the1008

objectives file.1009

type This selects the function to be applied. The key objectiveType is1010

used in the DSE configuration file.1011

variable This defines the variable to which the function is to be applied.1012

The key columnID is used to denote this parameter in the DSE con-1013

figuration file.1014

65



D4.3a - INTO-CPS Tool Chain User Manual (Public)

Figure 63: Definition of an internal objective.

Figure 63 shows the definition of an objective named energyConsumed,1015

which records the maximum value of the variable1016

{bodyFMU}.body.total_energy_used. This objective is recorded and1017

may be used later, primarily for the purpose of ranking designs, but it could1018

also be used for any other analysis required.1019

6.3.6 Objective Definitions: External Scripts1020

The second form of objective definition makes use of user-defined Python1021

scripts to allow bespoke analysis of simulation results to be launched auto-1022

matically and results recorded using the common format. The definition has1023

two parts: the construction of the Python script to perform the analysis and1024

the definition of the script’s required parameters in the DSE configuration1025

file, these two steps are described below.1026

Construction of the Script The outline functionality of an analysis script1027

is that, at the appropriate times, a DSE script calls it, passing four or more1028

arguments. The script uses these arguments to locate a raw simulation results1029

file (results.csv), processes those results and then writes the objective1030

values into an objectives file (objectives.json) for that simulation.1031

The first three arguments sent to the script are common to all scripts. These1032

are listed below.1033

argv 1 The absolute path to the folder containing the results.csv re-1034

sults file. This is also the path where the script finds the1035

objectives.json file.1036

argv 2 The name of the objective. This is the key against which the script1037

should save its results in the objectives file.1038

argv 3 The name of the scenario.1039

With this information the script can find the raw simulation data and also1040

determine where to save its results. The name of the scenario allows the script1041
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to locate any data files it needs relating to the scenario. For example, in the1042

case of the script measuring cross track error for the line following robot,1043

the script makes use of a data file that contains a series of coordinates that1044

represent the line to be followed. The name of this data file is map1px.csv.1045

It is placed into a folder with the same name as the scenario, which in this1046

case is studentMap. That folder is located in the userMetricScripts1047

folder, as shown in Figure 64. Using this method, the developer of an external1048

analysis script needs only to define the name of the data file they will need and1049

know that at runtime the script will be passed a path to a folder containing1050

the data file suitable for the scenario under test.

Figure 64: External analysis script data files for the “studentMap” scenario.
1051

Figure 65 shows an example of an external analysis script. In this case it1052

computes the cumulative deviation of the water level from some target level.1053

There are two distinct sections in the file, we shall refer to them as the1054

’common’ and ’script specific’ sections.1055

The common section contains core functions that are common to all ex-1056

ternal scripts. It reads in the three arguments that are common to all1057

scripts, and contains functions to help the user retrieve the data needed1058

by the analysis script, and to write the computed objective value into the1059

objectives.json file. It is recommended that this section be copied to1060

form the basis of any new external analysis scripts.1061

The second part of the example script shown is specific to the analysis to1062

be performed. The purpose of this section is to actually compute the value1063

of the objective from the results of a simulation. Generally it will have1064

three parts: reading in any analysis specific arguments such as the ID of1065

data in the results that it needs, using the data in results.csv to cal-1066
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Figure 65: External analysis script to calculate cumulative deviation in the
water tank example
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culate the value of the objective and finally write the objective value into1067

objectives.json.1068

In the ’Script Specific Section’ of Figure 65 we see the example of the script1069

calculating the cumulative deviation of the water level from a target level in1070

the water tank model. It starts by reading a further two arguments passed1071

when the script is launched and initializes the variables. The script then it-1072

erates through all rows of data in results.csv to calculate the cumulative1073

deviation which is then written to the objectives.json file in the final1074

line.1075

Figure 66: Definition of the external analysis functions for the line follower
robot.

Definition of External Analysis in DSE Configuration With the1076

analysis scripts constructed, the next step is to define their use in the DSE1077

configuration file. The definition essentially contains three parts:, a name for1078

the objective, the file name of the script and a list arguments to pass. The1079

name given to the objective allows it to be referenced in the objectives con-1080

straints and ranking sections of the DSE configuration. The file name tells1081

the DSE scripts which script to launch and the arguments define additional1082

data (over the standard three arguments described earlier) that the script1083

needs, such as the names of data it needs or constant values.1084

In Figure 67 we find the definition of the external analysis used in the three1085

tank water tank example. There are two analysis defined, the first is named1086

’cumulativeDeviation’ and the second is ’vCount’. In each there are two1087

parameters defined, the ’scriptFile’ contains the file name of the script file to1088

run in each case, while the ’scriptParameters’ parameter contains the list of1089
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additional arguments each needs.1090

Figure 67: Definition of the external analysis functions for the three water
tank model.

The purpose of both internal and external analysis functions is to populate1091

the objectives.json file with values that characterize the performance1092

of the designs being explored. Figure 68 shows an example objectives file1093

generated during a DSE of the three water tank example. There is an instance1094

of the objectives file created for each simulation in DSE, its primary use being1095

to inform the ranking of designs, but it may be used for any other analysis a1096

user wishes to define.

Figure 68: Contents of objectives.json file for a single simulation of
the three tank water tank

1097

6.3.7 Ranking1098

The final part of a DSE configuration file concerns the placing of designs in a1099

partial order according to their performance. The DSE currently supports a1100

Pareto method of ranking, as was shown earlier in Figure 59. The purpose of1101

the ranking section of the configuration is to define the pair of objectives that1102

will be used to rank the designs, and whether to maximize or minimize each.1103

Figure 69 shows an example of a ranking definition from the line following1104

robot example. Here the user has specified that the lap time and mean1105
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cross track error objectives will be used to rank. The use of ’-’ after each1106

indicates that the aim is to minimize both, whereas a ’+’ indicates the desire1107

to maximize.

Figure 69: Defining parameters and their preferred directions for ranking.
1108

Combining all these sections results in a complete DSE configuration, as1109

shown in Figure 70.1110
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Figure 70: A complete DSE configuration for the line follower robot example.
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7 Test Automation and Model Checking1111

Test Automation and Model Checking for INTO-CPS is provided by the RT-1112

Tester RTT-MBT tool. This section first describes installation and configu-1113

ration of RT-Tester MBT in Section 7.1. It then describes test automation1114

in Section 7.2 and model checking in Section 7.3. Note, that these features1115

are explained in more detail in the deliverables D5.2a [PLM16] and D5.2b1116

[BLM16], respectively.1117

7.1 Installation of RT-Tester RTT-MBT1118

In order to use RTT-MBT, a number of software packages must be installed.1119

These software packages have been bundled into two installers:1120

• VSI tools dependencies bundle:1121

This bundle is required on the Windows platform and installs the fol-1122

lowing third party software:1123

– Python 2.7.1124

– GCC 4.9 compiler suite, used to compile FMUs.1125

• VSI tools – VSI Test Tool Chain:1126

– RT-Tester 6.0, a stripped version of the RT-Tester core test system1127

that contains the necessary functionality for INTO-CPS.1128

– RT-Tester MBT 9.0, the model-based testing extension of RT-1129

Tester.1130

– RTTUI 3.9, the RT-Tester graphical user interface.1131

– Utility scripts to run RTT-MBT.1132

– Examples for trying out RTT-MBT.1133

These bundles can be downloaded via the download manager of the INTO-1134

CPS Application.1135

7.1.1 Setup of the RT-Tester User Interface1136

When the RT-Tester User Interface (RTTUI) is first started, a few configu-1137

ration settings must be made.1138
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• User name and company name (Figure 71a).1139

• Location of Bash shell (Figure 71b): You can safely skip this step by1140

clicking Next.1141

• Path to Python 2.7 executable (Figure 71c): Click Detect and then1142

Installation Path for auto-detection, or Browse to select manually.1143

• Location of RT-Tester (Figure 71d): Click Browse to select the direc-1144

tory of your RT-Tester installation. Note that if you did not specify1145

the Bash shell location in step 7.1.1, the version number might not be1146

properly detected.1147

(a) Configuring user. (b) Configuring Bash.

(c) Configuring Python. (d) Configuring RT-Tester.

Figure 71: RT-Tester GUI configuration.

7.2 Test Automation1148

Configuring and using a Test Project involves several activities. These are:1149

• Creating a test project.1150

• Defining tests.1151
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• Compiling test driver FMUs.1152

• Setting up test runs.1153

• Running tests.1154

• Evaluating test results.1155

These activities can be performed either solely using the RT-Tester graphical1156

user interface, or using a combination of the INTO-CPS Application and the1157

RT-Tester GUI. In this section we focus on describing the latter, since it1158

supports the complete set of features necessary for test automation. The1159

INTO-CPS Application currently only exposes a subset of these. A more1160

comprehensive description of the test automation workflow can be found in1161

deliverable D5.2a [PLM16].1162

In the INTO-CPS Application test automation functionality can be found1163

below the main activity Test-Data-Generation in the project browser. Before1164

using most of the test automation utilities, the license management process1165

has to be started. To this, end right-click on Test-Data-Generation and select1166

Start RT-Tester License Dongle (see Figure 72).

Figure 72: Starting the license management process.
1167

After developing the behavioural model in Modelio and exporting it to an1168

XMI file, test automation projects can be created from the INTO-CPS Ap-1169

plication. Such a project is then added as a sub-project within a containing1170

INTO-CPS Application project. To create a project, do the following:1171
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1. Right-click on Test-Data-Generation in the project browser and select1172

Create Test Data Generation Project (see Figure 73).1173

2. Specify a name for the project, select the XMI file containing the test1174

model and press Create, as shown in Figure 74.1175

Figure 73: Creating a test automation project.

The newly created sub-project and its directory hierarchy is displayed in the1176

project browser. Some directories and files of the RT-Tester project that1177

are not of great importance to the INTO-CPS workflow are hidden from the1178

browser. The following two folders are of special significance:1179

• TestProcedures contains symbolic test procedures where test objec-1180

tives are specified in an abstract way, for example by specifying Linear1181

Temporal Logic (LTL) formulas.1182

• From these symbolic test procedures, concrete executable (RT-Tester 6)1183

test procedures are generated, which then reside in the folder RTT_1184

TestProcedures.1185

The specification of test objectives is done using the RT-Tester GUI. The1186

relevant files can be opened in the RT-Tester GUI directly from the INTO-1187

CPS Application by double-clicking them:1188

• conf/generation.mbtconf allows you to specify the overall test1189

objectives of the test procedure. Test objectives can be specified as1190

LTL formulas, which must then be fulfilled during a test run. Test1191
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Figure 74: Test automation project specifics.

goals can also be specified by selecting structural elements from a tree1192

representation of the test model and then choosing a coverage metric1193

for that element. For example, the user might select a sub-component1194

of the System Under Test (SUT) and specify that all Basic Control1195

States (BCS) must be reached (see Figure 75), or that all transitions1196

must be exercised (TR) in a test run.1197

• conf/signalmap.csv allows you to configure the input and output1198

signals of the system under test (see Figure 76). This includes defining1199

the admissible signal latencies for checking the SUT’s outputs in a test1200

run. This file also allows you to restrict the range of the signals in order1201

to constrain these values during test data generation.1202

More details on the definition of tests can be found in deliverable D5.2a1203

[PLM16].1204

After defining the test objectives, a concrete test case can be created by right-1205

clicking on the symbolic test case under TestProcedures and then selecting1206

Solve (see Figure 77).1207
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Figure 75: Configuring a test goal.

Figure 76: Configuring signals.
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Figure 77: Generating a concrete test procedure.
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A solver component then computes the necessary timed inputs to realize the1208

test objectives. A concrete test procedure is generated that feeds a system1209

under test with these inputs and observes its outputs against expected results1210

derived from the test model. This test procedure will be placed in RTT_1211

TestProcedures and has the same name as the symbolic test procedure.1212

Figure 78 shows how test generation progresses.

Figure 78: Test data generation progress.
1213

A generated test procedure can be cast into an FMU, which can then be1214

run in a co-simulation against the system under test. To this end, right1215

click on the concrete test procedure and select Generate Test FMU (see1216

Figure 79). In cases where a real and perhaps physical system under test is1217

not available, a simulation of the system under test can be generated from1218

the behavioural model. To generate such an FMU, right-click on Simulation1219

an select Generate Simulation FMU as depicted in Figure 80.1220

In order to run a test, right-click on the test procedure and select Run Test1221
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Figure 79: Generating a test FMU.

Figure 80: Generating a simulation FMU.

(see Figure 81). Then specify the FMU of the system under test. If the sys-1222

tem under test is to be replaced by a simulation, press on the corresponding1223

Simulation button. The duration of the test is derived during test data gen-1224

eration and does not need to be manually specified. However, an appropriate1225

step size must be set. Finally, after making sure the COE is running, press1226

Run to start the test (see Figure 82).1227

Every test execution yields as its result an evaluation of test cases, i.e., each is1228

associated with a verdict of PASS, FAIL, or INCONCLUSIVE.10 The details1229

are found in the test log files below the folder testdata. See the RT-Tester1230

10The verdict can also be NOT TESTED. This means a test case has been included in
a test procedure, but a run that reaches it is still missing.
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Figure 81: Running a test.

user manual [Ver15a] for details.1231

The file testcase_tags.txt gives a condensed record of test case, ver-1232

dict, and point in a *.log file where a corresponding PASS, FAIL, or—1233

in case of INCONCLUSIVE—test case occurrence without assertion can1234

be found. The project-wide test-case verdict summary as well the require-1235

ment verdict summary can be found in the folder RTT_TestProcedures/1236

verification. More details on the evaluation of test runs can be found1237

in deliverable D5.2a [PLM16].1238

7.3 Model Checking1239

This section describes how to use the INTO-CPS Application as a front-1240

end to the LTL model checker of RT-Tester RTT-MBT. More details on the1241

algorithms used and the syntax of LTL formulas can be found in deliverable1242

D5.2b [BLM16].1243

Once an INTO-CPS project has been created (see Section 4.2), model check-1244

ing functionality can be found under the top-level activity Model Checking in1245

the project browser. Before getting started, the RT-Tester license manage-1246

ment process must be launched. To this end, right-click on Model Checking1247

and select Start RT-Tester License Dongle (see Figure 83). Model checking1248

projects are presented as sub-projects of INTO-CPS Application projects. In1249

order to add a new project,1250

1. Right-click on the top-level activity Model Checking in the project1251

browser and select Create Model Checking Project (see Figure 84).1252
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Figure 82: Configuring a test.

2. Provide a project name and the model that has been exported to XMI1253

from Modelio.1254
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Figure 83: Starting the RT-Tester license dongle.

Figure 84: Creating a model checking project.
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Figure 85: Specifying the model checking project.
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After pressing Create, a new node representing the model checking project is1255

added to the project browser.1256

The next step is to add LTL queries to the project:1257

1. Right click on the project and select Add LTL Query (see Figure 86).1258

2. Enter a name for the new query (see Figure 87).1259

3. To edit the LTL query, double click on the corresponding node in the1260

project browser (see Figure 88). The LTL formula can then be edited in1261

a text field. Note that the editor supports auto-completion for variable1262

names and LTL operators (see Figure 89).1263

4. Provide the upper bound for the bounded model checking query.1264

Figure 86: Adding an LTL formula.

Figure 87: Naming the new LTL formula.
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Figure 88: Opening the LTL formula editor.

To check the query, press Save & Check. A window opens and is filled with1265

the output of the model checking tool. The tool either reports that the query1266

holds within the specified number of steps — as depicted in Figure 90 — or1267

it prints a counterexample to demonstrate that the property does not hold.1268

1269

It is possible to configure abstractions11 for a particular model checking1270

project. To do so, double-click on the corresponding Abstractions node below1271

that project in the project browser. It is then possible to choose an abstrac-1272

tion method for each output variable of an environment component along1273

with making the associated setting. In Figure 91 the interval abstraction has1274

been selected for the output variable voltage. This abstraction has further1275

been configured to restrict the variable’s value within the interval [10, 12].1276

After pressing Save, this abstraction is applied to all model checking queries1277

in the current model checking project.1278

11Information on abstractions and their associated configuration items can be found in
deliverable D5.2b [BLM16].
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Figure 89: LTL formula editor.

Figure 90: Model checking result.
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Figure 91: Configuring abstractions.
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8 Traceability support for INTO-CPS1279

This section provides a description of tool support for traceability developed1280

as part of the INTO-CPS project.1281

8.1 Overview1282

Traceability support is divided into two steps: sending data from the tools1283

to the traceability database, and retrieving information from the database.1284

Currently, only the first part is available in prototypes in the different tools.1285

This is documented below.1286

8.2 INTO-CPS application1287

The traceablility daemon is now (since INTO-CPS App 2.1.19 RC) inte-1288

grated in the App and it starts with the App. Only Neo4J has to be down-1289

loaded. To do so, one can use the download-manager of the INTO-CPS App.1290

When downloaded, Neo4J needs to be extracted by hand into the folder1291

<user>/into-cps-projects/install (the archive file is located at1292

<user>/into-cps-projects/install_downloads after download).1293

Note that Neo4J is a singleton, so make sure all other instances of Neo4J are1294

down before starting the App.1295

Treaceability information is captured by the traceability daemon and stored1296

in a Neo4J database. The database is project specific and is deployed1297

on project change within the App. When running, Neo4J is accessible at1298

http://localhost:7474. Here one can view the current traceability1299

graph.1300

Username and password of the databases are always:1301

username = intoCPSApp1302

password = KLHJiK8k2378HKsg823jKKLJ89sjklJHBNf8j8JH7FxE1303

1304

To view the raw data from the database, right-click on the “traceability” entry1305

in the project browser (in the App) and select “view traceability graph” (see1306

figure 92). Select the database symbol, and click in “relationship types” on1307

“Trace”. This shows you the graph database. By default, the view is limited1308
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to 25 entries. To change this, edit the line MATCH p=()-[r:Trace]->()1309

RETURN p LIMIT 25 and set the limit to a different value.1310

Figure 92: Current view of the traceability in the app

8.3 Modelio1311

The Modelio module can be downloaded here: https://www.dropbox.1312

com/s/bad36t9f8x4n0gl/INTOCPS_1.1.03.jmdac?dl=0. Modelio1313

supports traceability for the following modelling activities:1314

• Model creation1315

• Model modification1316

Steps:1317

Go to Configuration > Modules... Select INTO-CPS and set the parameters.1318

To commit a change, right click on any element and use the INTO-CPS >1319

Commit command.1320

8.4 OpenModelica1321

The latest nightly builds of OpenModelica support traceability:1322
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Figure 93: Configuration of traceability features in Modelio

Figure 94: Commit the traceability information in Modelio
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Win32: https://build.openmodelica.org/omc/builds/windows/1323

nightly-builds/32bit/OpenModelica-latest.exeWin64: https:1324

//build.openmodelica.org/omc/builds/windows/nightly-builds/1325

64bit/OpenModelica-latest.exe1326

OpenModelica supports tracing the following modeling activities:1327

• Model creation1328

• Model modification1329

• FMU export1330

• Model description XML import1331

As a prerequisite for traceability support, Git should be installed in the1332

system.1333

To configure the traceability support, go to Tools > Options > Traceability,1334

select the traceability checkbox and set all the fields, the traceability daemon1335

IP-Address and Port (see Figure 95). By default, the port is 8083.1336

Figure 95: Configure the traceability settings in OpenModelica

Then, go to Tools > Options > General and set the working directory to1337

which you would like to export the FMU (see Figure 96).1338

Create a Modelica model via File > New Modelica Class or load a model via1339

File > Open Model/LibraryFile(s), see Figure 97.1340

After modification of the model/class, click the File > Save button, press1341

Ctrl + s or click the Save button from the menu bar shown below in the1342
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Figure 96: Set the FMU export directory in OpenModelica

Figure 97: Create or open a Class in OpenModelica

94



D4.3a - INTO-CPS Tool Chain User Manual (Public)

Figure 98. A dialog as shown below in Figure 99 will appear to enter the1343

commit description.1344

Figure 98: Save a model in OpenModelica

Figure 99: The commit message in OpenModelica

To trace the export of an FMU, load the Modelica model or create a new1345

model, then go to FMI > Export FMU (see Figure 100). OpenModela gen-1346

erates the FMU, commits and send the traceability information to daemon1347

automatically.1348

To import a modelDescription.xml file, go to FMI > Import FMU1349

Model Description. A dialog as shown in Figure 101 will appear. Select the1350

modelDescription.xml file and the output directory then press OK. The1351

Modelica model with SysML block inputs and outputs will be generated and1352

automatically loaded (see the left part of Figure 101). To send the traceability1353

information, double click on the model then go to Git > Traceability > Push1354

Traceability Information.1355

To visualize the traceability graph, click on the Traceability perspective but-1356

ton shown below.1357
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Figure 100: FMU export in OpenModelica

Figure 101: FMI model description import in OpenModelica

96



D4.3a - INTO-CPS Tool Chain User Manual (Public)

Figure 102: View traceability data in OpenModelica

8.5 20-sim1358

Use any version of 20-sim 4.6.3-intocps or higher. The one in the download1359

manager for version 2.1.19 RC is not sufficient. The first suitable release1360

bundle is 0.0.12.1361

The download can be found here:1362

https://www.dropbox.com/s/lgr461ddb97kl8h/20-sim-4.6.1363

3.7711-intocps-win32.exe?dl=1.1364

During installation, make sure you keep the Python option enabled. This is1365

necessity, even if you already have another Python installation on your PC.1366

This Python version will only overwrite Python versions you installed earlier1367

with 20-sim, it will not install other Python versions.1368

Currently, the actions “create model” and “modify model” are supported by1369

20-sim1370

In 20-sim, go to Tools > Version Control Toolbox > Traceability. First enable1371

“GIT version control” and insert a GIT repository, which can be an existing1372

GIT repository or a folder in the local file system. The model will be com-1373

mitted to this repository on a “save” (modify) or “save as” (create) action. If1374

the model does not reside in the GIT repository, it will also be copied to the1375

GIT repository on a “save” or “save as” action.1376

You can leave the “Write custom save messages” option unchecked, as it is1377

not currently fully functional.1378
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If you would like to send data to the traceability daemon as well, then you1379

can enable “INTO-CPS Traceability Daemon”. Below, you can then enter the1380

IP-address and Port of the daemon. If you run the INTO-CPS application1381

and traceability deamon locally, the IP-address is localhost and the port is1382

8083 by default.1383

Now, pressing “save” or “save as” in any form, will (copy and) commit your1384

model to the GIT repository, and then send the action you just performed1385

to the traceability daemon.1386

98



D4.3a - INTO-CPS Tool Chain User Manual (Public)

9 Code Generation for INTO-CPS1387

Of all the INTO-CPS tools, Overture, OpenModelica and 20-sim have the1388

ability, to varying degrees, to translate models into platform-independent C1389

source code. Overture can moreover translate VDM models written in the1390

executable subset of VDM++ [LLB11] (itself a subset of VDM-RT) to Java,1391

but C is the language of interest for the INTO-CPS technology.1392

The purpose of translating models into source code is twofold. First, the1393

source code can be compiled and wrapped as standalone FMUs for co-1394

simulation, such that the source tool is not required. Second, with the aid of1395

existing C compilers, the automatically generated source code can be com-1396

piled for specific hardware targets.1397

The INTO-CPS approach is to use 20-sim 4C to compile and deploy the code1398

to hardware targets, since the tool incorporates the requisite knowledge re-1399

garding compilers, target configuration etc. This is usually done for control1400

software modelled in one of the high-level modelling notations, after valida-1401

tion through the INTO-CPS tool chain. Deployment to target hardware is1402

also used for SiL and HiL validation and prototyping.1403

For each of the modelling and simulation tools of the INTO-CPS tool chain,1404

code generation is a standalone activity. As such, the reader should refer to1405

the tool-specific documentation referenced in Appendix B for guidance on1406

code generation. Deliverable D5.1d [HLG+15] contains the details of how1407

each tool approaches code generation.1408

The remainder of this section lists information about the code generation1409

capabilities of each tool. It describes what the user can expect currently1410

from each tool’s code generator, in the hopes that this will be helpful in1411

eliminating stumbling blocks for new users trying to quickly get started with1412

the INTO-CPS tool chain. Extensive guidance on how to tailor models for1413

problem-free translation to code can be found in the tools’ individual user1414

manuals, as referenced in Appendix B.1415

9.1 Overture1416

A complete description of Overture’s C code generator can be found in the1417

Overture User Manual, accessible through Overture’s Help system. As a1418

quick-start guide, this section only provides an introduction to invoking the1419

C code generator, and an overview of the features of VDM-RT that are1420
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currently considered stable from a code generation point of view. Please note1421

that exporting a source code FMU with Overture (Section 5.1) automatically1422

invokes the code generator and packages the result as an FMU.1423

The C code generator is invoked from the context menu in the Project Ex-1424

plorer as shown in Figure 103. The code generator currently supports the

Figure 103: Invoking the code generator.
1425

following VDM-RT language constructs:1426

• Basic data types and operations: integers, reals, booleans, etc.1427

• The is_ type test for basic types.1428

• Quote types.1429

• let expressions.1430

• Pattern matching.1431

• For and while loops.1432

• case expressions.1433

• Record types.1434

• Products.1435

• Aggregate types and operations: sets, sequences, maps (to a limited1436

extent).1437

• Object-oriented features: classes and class field access, inheritance,1438

method overloading and overriding, the self keyword, subclass re-1439

sponsibility, is not yet specified, multiple constructors, and1440

constructor calls within constructors.1441

• The time expression.1442

The following language features are not yet supported:1443

• Lambda expressions.1444
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• Pre-conditions, post-conditions and invariants.1445

• Quantifiers.1446

• Type queries on class instances.1447

• File I/O via the I/O library.1448

Most importantly, the development of Overture’s C code generator is now be-1449

ing geared toward resource-constrained embedded platforms. Improvements1450

are currently being made to enable deployment of the generated code on PIC1451

and ATmega microcontrollers.1452

A key feature of this development is the use of a garbage collector for memory1453

management. Generating a VDM-RT model to C code via the context menu1454

results in a main.c file containing a skeletal main() function. This function1455

contains calls to vdm_gc_init() and vdm_gc_shutdown(), the garbage1456

collector initialization and shutdown functions. The collector proper can not1457

be invoked automatically, so calls to the essential function vdm_gc() must1458

be inserted manually in the main code, for instance after each repetition of a1459

cyclic task. The source code FMU exporter, on the other hand, can handle1460

automatic invocation of the garbage collector, so no manual intervention is1461

required. Please note that it is generally unsafe to insert calls to vdm_gc()1462

in the generated code.1463

9.2 20-sim1464

20-sim supports ANSI-C and C++ code generation through the usage of1465

external and user-modifiable code-generation templates. Currently only a1466

subset of the supported 20-sim modelling language elements can be exported1467

as ANSI-C or C++ code code. The exact supported features depend on the1468

chosen template and its purpose and are discussed in Section 5.2.1469

The main purpose of the 20-sim code generator is to export control systems.1470

Therefore the focus in on running code on bare-bone targets (e.g. Arduino)1471

or as a real-time task on a real-time operating system.1472

The code generated by 20-sim does not contain any target-related or operat-1473

ing system specific code. The exported code is generated such that it can be1474

embedded in an external software project. For running 20-sim generated code1475

on a target, you can use 20-sim 4C. This is a tool that extends the 20-sim1476

generated code with target code based on target templates [Con16].1477
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9.3 OpenModelica1478

OpenModelica supports code generation from Modelica to source-code tar-1479

geting both ANSI-C and C++. From the generated source code, co-simulation1480

and model-exchange FMUs can be built. Currently, the only supported solver1481

in the generated co-simulation FMUs is forward Euler. Work to support ad-1482

ditional solvers is underway. The ability to deploy the generated code to1483

specific hardware targets will be supported via 20-sim 4C.1484

9.4 RT-Tester/RTT-MBT1485

When generating test FMUs from SysML discrete-event state-chart specifi-1486

cations using RTTester/RTT-MBT, the user should be aware of the following1487

sources of errors:1488

• Livelock resulting from a transition cycle in the state-chart specification1489

in which all transition guards are true simultaneously. This can be1490

checked separately using a livelock checker.1491

• Race conditions arising from parallel state-charts assigning different1492

values to the same variable. Model execution in this case will deadlock.1493

• State-charts specifying a replacement SUT must be deterministic.1494

10 Issue handling1495

Should you experience an issue while using one or more of the INTO-CPS1496

tools, please take the time to report the issue to the INTO-CPS project team,1497

so we can help you resolve it as soon as possible.1498

The following three small sub-sections will guide you through the three simple1499

steps of issue handling and reporting.1500

10.1 Are you using the newest INTO-CPS release?1501

Before you go any further with your current issue, please check that the1502

INTO-CPS version you are using is the newest. The version number is part1503

of the file name of the ZIP-bundle of the release. To find the list of released1504
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INTO-CPS bundle versions, and to see what the current version of INTO-1505

CPS is, please visit1506

https://github.com/into-cps/intocps-ui/releases/1507

10.2 Has the issue already been reported?1508

To make it easy for you to check whether the issue you are experiencing is1509

an already known one, we have created a list of all currently known issues1510

across all the INTO-CPS tools, with links directly to the online issue report1511

page of the relevant tool supplier. Have a quick look at the list, and if your1512

issue is already known, we recommend you follow the link and read more1513

about the specifics of the issue. Perhaps someone has found a work-around1514

or perhaps you have new information to add that might help the developers1515

solve the issue faster.1516

For the list of currently known issues, please visit1517

http://into-cps.github.io/weekly-issue/index.html1518

Note that some of the issue tracker sites might require you to register before1519

you can view or submit issues. Registration is free.1520

10.3 Reporting a new issue1521

If you have followed the steps in the two previous sections and are now1522

certain that you have spotted a new issue relating to a specific INTO-CPS1523

tool, please visit the issue tracker site for that tool and report it. To ease1524

this process we have listed direct links for each tool to their relevant online1525

issue reporting page. To see the list of issue tracker links please visit1526

http://into-cps.github.io/report-an-issue.html1527

11 Conclusions1528

This deliverable is the user manual for the INTO-CPS tool chain after the1529

second year of the project. The tool chain supports model-based design and1530

validation of CPSs, with an emphasis on multi-model co-simulation.1531
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Several independent simulation tools are orchestrated by a custom co-simu-1532

lation orchestration engine, which implements both fixed and variable step1533

size co-simulation semantics. A multi-model thus co-simulated can be fur-1534

ther verified through automated model-based testing and bounded model1535

checking.1536

The tool chain benefits from a cohesive management interface, the INTO-1537

CPS Application, the main gateway to modelling and validation with the1538

INTO-CPS technology. Following the manual should give a new user of the1539

INTO-CPS tool chain an understanding of all the elements of the INTO-CPS1540

vision for co-simulation. This manual is accompanied by tutorial material1541

and guidance on the main INTO-CPS tool chain website,1542

http://into-cps.github.io1543

Features that have not yet been fully developed or integrated with the INTO-1544

CPS Application are currently being addressed and are targeted for the final1545

year of the INTO-CPS project.1546
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A List of Acronyms1681

20-sim Software package for modelling and simulation of dynamic systems
API Application Programming Interface
AST Abstract Syntax Tree
AU Aarhus University
BCS Basic Control States
CLE ClearSy
CLP Controllab Products B.V.
COE Co-simulation Orchestration Engine
CORBA Common Object Request Broker Architecture
CPS Cyber-Physical Systems
CT Continuous-Time
DE Discrete Event
DESTECS Design Support and Tooling for Embedded Control Software
DSE Design Space Exploration
FMI Functional Mockup Interface
FMI-Co Functional Mockup Interface – for Co-simulation
FMI-ME Functional Mockup Interface – Model Exchange
FMU Functional Mockup Unit
HiL Hardware-in-the-Loop
HMI Human Machine Interface
HW Hardware
ICT Information Communication Technology
IDE Integrated Design Environment
LTL Linear Temporal Logic
M&S Modelling and Simulation
MARTE Modeling and Analysis of Real-Time and Embedded Systems
MBD Model-based Design
MBT Model-based Testing
MC/DC Modified Decision/Condition Coverage
MDE Model Driven Engineering
MiL Model-in-the-Loop
MIWG Model Interchange Working Group
OMG Object Management Group
OS Operating System
PID Proportional Integral Derivative
PROV-N The Provenance Notation
RPC Remote Procedure Call
RTT Real-Time Tester
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SiL Software-in-the Loop
SMT Satisfiability Modulo Theories
ST Softeam
SUT System Under Test
SVN Subversion
SysML Systems Modelling Language
TA Test Automation
TE Test Environment
TR TRansitions
TRL Technology Readiness Level
TWT TWT GmbH Science & Innovation
UML Unified Modelling Language
UNEW University of Newcastle upon Tyne
UTP Unifying Theories of Programming
UTRC United Technologies Research Center
UY University of York
VDM Vienna Development Method
VSI Verified Systems International
WP Work Package
XML Extensible Markup Language
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B Background on the Individual Tools1682

This appendix provides background information on each of the independent1683

tools of the INTO-CPS tool chain.1684

B.1 Modelio1685

Modelio is a comprehensive MDE [Fav05] workbench tool which supports1686

the UML2.x standard. Modelio adds modern Eclipse-based graphical envi-1687

ronment to the solid modelling and generation know-how obtained with the1688

earlier Softeam MDE workbench, Objecteering, which has been on the mar-1689

ket since 1991. Modelio provides a central repository for the local model,1690

which allows various languages (UML profiles) to be combined in the same1691

model, abstraction layers to be managed and traceability between different1692

model elements to be established. Modelio makes use of extension modules,1693

enabling the customization of this MDE environment for different purposes1694

and stakeholders. The XMI module allows models to be exchanged between1695

different UML modelling tools. Modelio supports the most popular XMI1696

UML2 flavors, namely EMF UML2 and OMG UML 2.3. Modelio is one of1697

the leaders in the OMG Model Interchange Working Group (MIWG), due to1698

continuous work on XMI exchange improvements.1699

Among the extension modules, some are dedicated to IT system architects.1700

For system engineering, SysML or MARTE modules can be used. They1701

provide dedicated modelling support for dealing with general, software and1702

hardware aspects of embedded or cyber physical systems. In addition, sev-1703

eral utility modules are available, such as the Document Publisher which1704

provides comprehensive support for the generation of different types of doc-1705

ument.1706

Modelio is highly extendable and can be used as a platform for building1707

new MDE features. The tool enables users to build UML2 Profiles, and to1708

combine them with a rich graphical interface for dedicated diagrams, model1709

element property editors and action command controls. Users can use several1710

extension mechanisms: light Python scripts or a rich Java API, both of which1711

provide access to Modelio‘s model repository and graphical interface.1712
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B.2 Overture1713

The Overture platform [LBF+10] is an Eclipse-based integrated development1714

environment (IDE) for the development and validation of system specifica-1715

tions in three dialects of the specification language of the Vienna Develop-1716

ment Method. Overture is distributed with a suite of examples and step-by-1717

step tutorials which demonstrate the features of the three dialects. A user1718

manual for the platform itself is also provided [LLJ+13], which is accessible1719

through Overture’s help system. Although certain features of Overture are1720

relevant only to the development of software systems, VDM itself can be used1721

for the specification and validation of any system with distinct states, known1722

as discrete-event systems, such as physical plants, protocols, controllers (both1723

mechanical and software) etc., and Overture can be used to aid in validation1724

activities in each case.1725

Overture supports the following activities:1726

• The definition and elaboration of syntactically correct specifications in1727

any of the three dialects, via automatic syntax and type validation.1728

• The inspection and assay of automatically generated proof obligations1729

which ensure correctness in those aspects of specification validation1730

which can not be automated.1731

• Direct interaction with a specification via an execution engine which1732

can be used on those elements of the specification written in an exe-1733

cutable subset of the language.1734

• Automated testing of specifications via a custom test suite definition1735

language and execution engine.1736

• Visualization of test coverage information gathered from automated1737

testing.1738

• Visualization of timing behaviours for specifications incorporating tim-1739

ing information.1740

• Translation to/from UML system representations.1741

• For specifications written in the special executable subset of the lan-1742

guage, obtaining Java implementations of the specified system auto-1743

matically.1744

For more information and tutorials, please refer to the documentation dis-1745

tributed with Overture.1746
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The following is a brief introduction to the features of the three dialects of1747

the VDM specification language.1748

VDM-SL This is the foundation of the other two dialects. It supports the1749

development of monolithic state-based specifications with state transition1750

operations. Central to a VDM-SL specification is a definition of the state1751

of the system under development. The meaning of the system and how it1752

operates is conveyed by means of changes to the state. The nature of the1753

changes is captured by state-modifying operations. These may make use of1754

auxiliary functions which do not modify state. The language has the usual1755

provisions for arithmetic, new dependent types, invariants, pre- and post-1756

conditions etc. Examples can be found in the VDM-SL tutorials distributed1757

with Overture.1758

VDM++ The VDM++ dialect supports a specification style inspired by1759

object-oriented programming. In this specification paradigm, a system is1760

understood as being composed of entities which encapsulate both state and1761

behaviour, and which interact with each other. Entities are defined via tem-1762

plates known as classes. A complete system is defined by specifying instances1763

of the various classes. The instances are independent of each other, and they1764

may or may not interact with other instances. As in object-oriented program-1765

ming, the ability of one component to act directly on any other is specified1766

in the corresponding class as a state element. Interaction is naturally carried1767

out via precisely defined interfaces. Usually a single class is defined which1768

represents the entire system, and it has one instance, but this is only a con-1769

vention. This class may have additional state elements of its own. Whereas a1770

system in VDM-SL has a central state which is modified throughout the life-1771

time of the system, the state of a VDM++ system is distributed among all of1772

its components. Examples can be found in the VDM++ tutorials distributed1773

with Overture.1774

VDM-RT VDM-RT is a small extension to VDM++ which adds two pri-1775

mary features:1776

• The ability to define how the specified system is envisioned to be allo-1777

cated on a distributed execution platform, together with the commu-1778

nication topology.1779

• The ability to specify the timing behaviours of individual components,1780

as well as whether certain behaviours are meant to be cyclical.1781
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Finer details can be specified, such as execution synchronization and mu-1782

tual exclusion on shared resources. A VDM-RT specification has the same1783

structure as a VDM++ specification, only the conventional system class of1784

VDM++ is mandatory in VDM-RT. Examples can be found in the VDM-RT1785

tutorials distributed with Overture.1786

B.3 20-sim1787

20-sim [Con13, Bro97] is a commercial modelling and simulation software1788

package for mechatronic systems. With 20-sim, models can be created graph-1789

ically, similar to drawing an engineering scheme. With these models, the1790

behaviour of dynamic systems can be analyzed and control systems can be1791

designed. 20-sim models can be exported as C-code to be run on hardware1792

for rapid prototyping and HiL-simulation. 20-sim includes tools that allow1793

an engineer to create models quickly and intuitively. Models can be cre-1794

ated using equations, block diagrams, physical components and bond graphs1795

[KR68]. Various tools give support during the model building and simulation.1796

Other toolboxes help to analyze models, build control systems and improve1797

system performance. Figure 104 shows 20-sim with a model of a controlled

Figure 104: Example of a hexapod model in 20-sim.
1798

hexapod. The mechanism is generated with the 3D Mechanics Toolbox and1799

connected with standard actuator and sensor models from the mechanics li-1800

brary. The hexapod is controlled by PID controllers which are tuned in the1801
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frequency domain. Everything that is required to build and simulate this1802

model and generate the controller code for the real system is included inside1803

the package.1804

The 20-sim Getting Started manual [KG16] contains examples and step-by-1805

step tutorials that demonstrate the features of 20-sim. More information on1806

20-sim can be found at http://www.20sim.com and in the user manual1807

at http://www.20sim.com/webhelp [KGD16]. The integration of 20-1808

sim into the INTO-CPS tool-chain is realized via the FMI standard.1809

B.4 OpenModelica1810

OpenModelica [Fri04] is an open-source Modelica-based modelling and sim-1811

ulation environment. Modelica [FE98] is an object-oriented, equation based1812

language to conveniently model complex physical systems containing, e.g.,1813

mechanical, electrical, electronic, hydraulic, thermal, control, electric power1814

or process-oriented subcomponents. The Modelica language (and OpenMod-1815

elica) supports continuous, discrete and hybrid time simulations. OpenMod-1816

elica already compiles Modelica models into FMU, C or C++ code for simula-1817

tion. Several integration solvers, both fixed and variable step size, are avail-1818

able in OpenModelica: euler, rungekutta, dassl (default), radau5, radau3,1819

radau1.1820

OpenModelica can be interfaced to other tools in several ways as described1821

in the OpenModelica user’s manual [Ope]:1822

• via command line invocation of the omc compiler1823

• via C API calls to the omc compiler dynamic library1824

• via the CORBA interface1825

• via OMPython interface [GFR+12]1826

OpenModelica has its own scripting language, Modelica script (mos files),1827

which can be used to perform actions via the compiler API, such as load-1828

ing, compilation, simulation of models or plotting of results. OpenModelica1829

supports Windows, Linux and Mac Os X.1830

The integration of OpenModelica into the INTO-CPS tool chain is realized1831

via compliance with the FMI standard, and is described in deliverable D4.1b1832

[PBLG15].1833
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B.5 RT-Tester1834

The RT-Tester [Ver15a] is a test automation tool for automatic test gener-1835

ation, test execution and real-time test evaluation. Key features include a1836

strong C/C++-based test script language, high performance multi-threading,1837

and hard real-time capability. The tool has been successfully applied in avion-1838

ics, rail automation, and automotive test projects. In the INTO-CPS tool1839

chain, RT-Tester is responsible for model-based testing, as well as for model1840

checking. This section gives some background information on the tool from1841

these two perspectives.1842

B.5.1 Model-based Testing1843

The RT-Tester Model Based Test Case and Test Data Generator (RTT-1844

MBT) [Ver15b] supports model-based testing (MBT), that is, automated1845

generation of test cases, test data, and test procedures from UML/SysML1846

models. A number of common modelling tools can be used as front-ends for1847

this. The most important technical challenge in model-based test automation1848

is the extraction of test cases from test models. RTT-MBT combines an SMT1849

solver with a technique akin to bounded model checking so as to extract finite1850

paths through the test model according to some predefined criterion. This1851

criterion can, for instance, be MC/DC coverage, or it can be requirements1852

coverage (if the requirements are specified as temporal logic formulae within1853

the model). A further aspect is that the environment can be modelled within1854

the test model. For example, the test model may contain a constraint such1855

that a certain input to the system-under-test remains in a predefined range.1856

This aspect becomes important once test automation is lifted from single test1857

models to multi-model cyber-physical systems. The derived test procedures1858

use the RT-Tester Core as a back-end, allowing the system under test to be1859

provided on real hardware, software only, or even just simulation to aid test1860

model development.1861

Further, RTT-MBT includes requirement tracing from test models down to1862

test executions and allows for powerful status reporting in large scale testing1863

projects.1864

B.5.2 Model Checking of Timed State Charts1865

RTT-MBT applies model checking to behavioural models that are specified1866

as timed state charts in UML and SysML, respectively. From these models,1867
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a transition relation is extracted and represented as an SMT formula in bit-1868

vector theory [KS08], which is then checked against LTL formulae [Pnu77]1869

using the algorithm of Biere et al. [BHJ+06]. The standard setting of RTT-1870

MBT is to apply model checking to a single test model, which consists of the1871

system specification and an environment.1872

• A component called TestModel that is annotated with stereotype TE.1873

• A component called SystemUnderTest that is annotated with stereo-1874

type SUT.1875

RTT-MBT uses the stereotypes to infer the role of each component. The in-1876

teraction between these two parts is implemented via input and output inter-1877

faces that specify the accessibility of variables using UML stereotypes.1878

• A variable that is annotated with stereotype SUT2TE is written by1879

the system model and readable by the environment.1880

• A variable that is annotated with stereotype TE2SUT is written by1881

the environment and read by the system model as an input.1882

A simple example is depicted in Figure 105, which shows a simple composite1883

structure diagram in Modelio for a turn indication system. The purpose1884

of the system is to control the lamps of a turn indication system in a car.1885

Further details are given in [Ver13]. The test model consists of the two1886

aforementioned components and two interfaces:1887

• Interface1 is annotated with stereotype TE2SUT and contains three1888

variables voltage, TurnIndLvr and EmerSwitch. These variables1889

are controlled by the environment and fed to the system under test as1890

inputs.1891

• Interface2 is annotated with stereotype SUT2TE and contains two1892

variables LampsLeft and LampsRight. These variables are con-1893

trolled by the system under test and can be read by the environment.1894

Observe that the two variables LampsLeft and LampsRight have type
int, but should only hold values 0 or 1 to indicate states on or off. A
straightforward system property that could be verified would thus be that
LampsLeft and LampsRight indeed are only assigned 0 or 1, which could
be expressed by the following LTL specification:

G(0 ≤ LampsLeft ≤ 1 ∧ 0 ≤ LampsRight ≤ 1)

A thorough introduction with more details is given in the RTT-MBT user1895

manual [Ver13].1896
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Figure 105: Simple model that highlights interfaces between the environment
and the system-under-test.
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C Underlying Principles1897

The INTO-CPS tool chain facilitates the design and validation of CPSs1898

through its implementation of results from a number of underlying principles.1899

These principles are co-simulation, design space exploration, model-based1900

test automation and code generation. This appendix provides an introduc-1901

tion to these concepts.1902

C.1 Co-simulation1903

Co-simulation refers to the simultaneous simulation of individual models1904

which together make up a larger system of interest, for the purpose of ob-1905

taining a simulation of the larger system. A co-simulation is performed by a1906

co-simulation orchestration engine. This engine is responsible for initializing1907

the individual simulations as needed; for selecting correct time step sizes such1908

that each constituent model can be simulated successfully for that duration,1909

thus preventing time drift between the constituent simulations; for asking1910

each individual simulation to perform a simulation step; and for synchro-1911

nizing information between models as needed after each step. The result of1912

one such round of simulations is a single simulation step for the complete1913

multi-model of the system of interest.1914

As an example, consider a very abstract model of a nuclear power plant. This1915

consists of a nuclear reactor core, a controller for the reactor, a water and1916

steam distribution system, a steam-driven turbine and a standard electrical1917

generator. All these individual components can be modelled separately and1918

simulated, but when composed into a model of a nuclear power plant, the1919

outputs of some become the inputs of others. In a co-simulation, outputs1920

are matched to inputs and each component is simulated one step at a time1921

in such a way that when each model has performed its simulation step, the1922

overall result is a simulation step of the complete power plant model. Once1923

the correct information is exchanged between the constituent models, the1924

process repeats.1925

C.2 Design Space Exploration1926

During the process of developing a CPS, either starting from a completely1927

blank canvas or constructing a new system from models of existing compo-1928

nents, the architects will encounter many design decisions that shape the1929
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final product. The activity of investigating and gathering data about the1930

merits of the different choices available is termed Design Space Exploration.1931

Some of the choices the designer will face could be described as being the1932

selection of parameters for specific components of the design, such as the1933

exact position of a sensor, the diameter of wheels or the parameters affecting1934

a control algorithm. Such parameters are variable to some degree and the1935

selection of their value will affect the values of objectives by which a design1936

will be measured. In these cases it is desirable to explore the different values1937

each parameter may take and also different combinations of these parameter1938

values if there are more than one parameter, to find a set of designs that best1939

meets its objectives. However, since the size of the design space is the prod-1940

uct of the number of parameters and the number of values each may adopt,1941

it is often impractical to consider performing simulations of all parameter1942

combinations or to manually assess each design.1943

The purpose of an automated DSE tool is to help manage the exploration1944

of the design space, and it separates this problem into three distinct parts:1945

the search algorithm, obtaining objective values and ranking the designs1946

according to those objectives. The simplest of all search algorithms is the1947

exhaustive search, and this algorithm will methodically move through each1948

design, performing a simulation using each and every one. This is termed1949

an open loop method, as the simulation results are not considered by the1950

algorithm at all. Other algorithms, such as a genetic search, where an initial1951

set of randomly generated individuals are bred to produce increasingly good1952

results, are closed loop methods. This means that the choice of next design1953

to be simulated is driven by the results of previous simulations.1954

Once a simulation has been performed, there are two steps required to close1955

the loop. The first is to analyze the raw results output by the simulation to1956

determine the value for each of the objectives by which the simulations are1957

to be judged. Such objective values could simply be the maximum power1958

consumed by a component or the total distance traveled by an object, but1959

they could also be more complex measures, such as the proportion of time1960

a device was operating in the correct mode given some conditions. As well1961

as numerical objectives, there can also be constraints on the system that1962

are either passed or failed. Such constraints could be numeric, such as the1963

maximum power that a substation must never exceed, or they could be based1964

on temporal logic to check that undesirable events do not occur, such as all1965

the lights at a road junction not being green at the same time.1966

The final step in a closed loop is to rank the designs according to how well1967

each performs. The ranking may be trivial, such as in a search for a design1968
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that minimizes the total amount of energy used, or it may be more complex1969

if there are multiple objectives to optimize and trade off. Such ranking1970

functions can take the form of an equation that returns a score for each1971

design, where the designs with the highest/lowest scores are considered the1972

best. Alternatively, if the relationship between the desired objectives is not1973

well understood, then a Pareto approach can be taken to ranking, where1974

designs are allocated to ranks of designs that are indistinguishable from each1975

other, in that each represents an optimum, but there exist different tradeoffs1976

between the objective values.1977

C.3 Model-Based Test Automation1978

The core fragment of test automation activities is a model of the desired1979

system behaviour, which can be expressed in SysML. This test model in-1980

duces a transition relation, which describes a collection of execution paths1981

through the system, where a path is considered a sequence of timed data1982

vectors (containing internal data, inputs and outputs). The purpose of a test1983

automation tool is to extract a subset of these paths from the test model1984

and turn these paths into test cases, respectively test procedures. The test1985

procedures then compare the behaviour of the actual system-under-test to1986

the path, and produce warnings once discrepancies are observed.1987

C.4 Code Generation1988

Code generation refers to the translation of a modelling language to a com-1989

mon programming language. Code generation is commonly employed in con-1990

trol engineering, where a controller is modelled and validated using a tool1991

such as 20-sim, and finally translated into source code to be compiled for1992

some embedded execution platform, which is its final destination.1993

The relationship that must be maintained between the source model and1994

translated program must be one of refinement, in the sense that the trans-1995

lated program must not do anything that is not captured by the original1996

model. This must be considered when translating models written in high-1997

level specification languages, such as VDM. The purpose of such languages1998

is to allow the specification of several equivalent implementations. When1999

a model written in such a language is translated to code, one such imple-2000

mentation is essentially chosen. In the process, any non-determinism in the2001

specification, the specification technique that allows a choice of implemen-2002
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tations, must be resolved. Usually this choice is made very simple by re-2003

stricting the modelling language to an executable subset, such that no such2004

non-determinism is allowed in the model. This restricts the choice of imple-2005

mentations to very few, often one, which is the one into which the model is2006

translated via code generation.2007
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